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CHAPTER 1
Overview

The TIBCO EBX® Information Governance Add-on provides a "governance repository" to manage
the metadata applied to any assets registered with TIBCO EBX® (tables, fields, groups of fields, data
types, workflows, rule). These assets can be master data that is under the control of the MDM system
or any data managed by other applications.
The repository relies on the ISO-IEC 11179 standard (Information technology - Metadata registries
MDR) that defines a robust data structure for collecting and sharing the knowledge applied to any
data. It also provides a standard vocabulary defining key concepts that a metadata repository must
apply. This means that the knowledge collected in the "governance repository" is independent of the
tool. In this user guide, the term 'ISO' refers to the 'ISO-IEC 11179' standard.
Since the governance repository is built using EBX®, it benefits from the MDM features to govern
the metadata as real master data. It provides:

• UI for authoring the metadata,

• Search functions based on formal criteria or fuzzy search,

• Automatic creation of data hierarchy views based on the association between the data,

• Permissions management,

• History of all operations applied to the data,

• Collaborative workflows to build governance processes,

• Version management using data spaces,

• Integration via Java API,

• Export/import of XML, CSV, Excel, etc.

The governance repository uses three innovative functions to improve metadata quality:

• The add-on automatically generates a 'Logical name' for new elements entered into the repository.
This name is based on the underlying data model loaded into EBX®. This means that the logical
name is related to the logical layer of data management. This name is inherited by another
field known as the 'universal name' which can be changed by the repository administrator. The
'universal name' is related to the semantic layer of data management. Using this type of two-level
naming approach ensures a clear relation between the logical and semantic data layers.

• A de-duplication process can be executed when new information is entered into the repository. If
elements are duplicated, a shared definition of the related metadata can be defined.

• At any time, the relations between the logical layer (data models, workflow, rules) and the
semantic layer (governance repository) are synchronized through a user service.
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Based on EBX® permission management, any type of user profile can be created with rights that
are specifically suited to organizational requirements. The following profiles are often required:
Administrator, Data Owner, Data Account, User.
Online help
A tool tip link is available at the 'EBX® Information Governance Add-on' level as highlighted below.
This link allows you to view the current user guide in PDF format.

Special notation key

Special notation key:

Important recommendation for the use of the add-on.

This feature is not yet available in the current release.
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CHAPTER 2
Repository key concepts

This chapter contains the following topics:

1. Repository structure

2. Types of data assets (Logical data types)

3. Types of ISO items

4. Relation between data asset types and ISO items

5. Data asset de-duplication process

6. Data staging applied to the add-on repository

7. Metadata views

2.1 Repository structure
Each data asset registered with EBX® (table, field, complex data type, etc.) is linked to an ISO-
IEC 11179 item also called an 'Administered Item'. These ISO items represent the structure of the
repository and support the logical and semantic descriptions: identification, definition, synonym,
examples, classification, properties in the logical modeling, etc. The descriptions are localized by
language and context. This architecture scheme is what comprises the "governance repository".
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The figure below highlights the links between the ISO items and the data assets known by EBX®.

The relationships between the data assets and the ISO items rely on these rules:

• When applied to a 'Data value' and 'Data type', the relationship with the ISO item is unique (a one-
to-one relationship). In other words, there is a direct mapping between the data assets in EBX®
and the ISO items.

• When applied to the other data assets (table, complex data type, etc.) the relationship with the
ISO items is many-to-one. This means that a single ISO item can be associated with many data
assets-depending on how the de-duplication governance process is applied. For example, an 'age'
property can be a unique ISO item, whereas there can be multiple 'age' fields located in different
tables such as 'Employee', 'Customer', 'Company', etc. The governance removes duplication of
the description by considering that all fields with the same name are described using a unique
property.

2.2 Types of data assets (Logical data types)
A data asset is registered with EBX® through a data model. It is represented by a data structure
definition such as a table, a field, a domain, etc. But it can also represent a data value, either to get
examples of data when a concept is documented, or to define a value domain (enumeration of data).
The data model used to obtain information to apply governance to is either:

• a data model used by EBX® to manage reference and master data, or

• any data model coming from an external systems (application, case tools, business XML
languages) for which governance is accepted.
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The types of data assets that are governed are described in the table below. They are also known as
'Logical data types'.

Type of data asset
(Logical data type)

Definition

Table A table as defined in SQL. With the semantic data management mode in EBX®, the data structure of
a table can be a complex data type that includes multi-occurrence fields.

Domain A group of tables. A data model can be arranged into domains and sub-domains of tables.

Field Atomic data with a simple data type: integer, string, etc. or a complex data type.

Group of fields With a 'Group of fields' you can arrange fields around topics. For example, 'Address' with its related
fields.

Complex data type A reusable data structure built with fields. A complex data type can be used by tables and groups of
fields.

Data type Atomic data type (Integer, String, etc.) with facets for data validation (length, enumeration, etc.).

Association Provides an abstraction over an existing relationship in the data model and enables an easy, model-
driven integration of associated objects in the user interface and in data services.

Data value Actual data value in EBX®.

Special notation:

The 'Workflow' and 'Rule' types of data assets are not managed in the current version of the add-on.

2.3 Types of ISO items
The ISO items, also called 'Administered Items', represent the foundation of the governance repository.
If needed, you can edit the descriptive name of these elements. To perform these edits:
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• Open 'Reference data' > 'ISO Type'. Double-click to open an item and after editing its description,
save and close.
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• As the following image illustrates, the ISO type property populates with the updated name.
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The table below describes the following items: 'Data Element', 'Data Element Concept' (D.E.C.),
'Object Class', 'Property', 'Value Domain', 'Context'.

ISO-IEC 11179 item

(Administered Item)

Definition

Data Element Actual value of a data element, or unit of data. A 'Data Element' is used as an
example to enrich the definition of an ISO item. A 'Data Element' exists as the link
between a 'Data Element Concept' (D.E.C.) and a 'Value Domain'.

Data Element Concept (D.E.C.) A 'Data Element Concept' (D.E.C.) is the association between an 'Object Class'
and a 'Property'. This is not similar to a field in a table because a property can be
associated with many tables. For instance, the 'Employee', 'Client' and 'Company'
tables can each have an 'age' field. In this case, an 'age' property can be linked to the
'age' fields in each of the three tables.

Object Class An 'Object Class' is a representation of a composite data structure such as a business
object or a group of related information.

Property A 'Property' is an atomic item. The association of a property with an 'Object Class'
represents a 'Data Element Concept'. A property can be associated with many fields
with the same name in different tables. For instance, the 'Name' property can be
linked to the 'name' fields that are located in the 'Employee', 'Supplier' and 'Partner'
tables.

Value Domain A 'Value Domain' is either an atomic data type (integer, string, etc.) or an
enumeration that provides a list of possible values for a 'Property'.

Context A 'Context' lets you declare representational spaces in which the ISO item definition
is provided. The most basic context is one related to languages and geographical
zones. However, any type of context can be defined such as: organization, level of
maturity, user profile, sources, etc.

2.4 Relation between data asset types and ISO items
The governance repository maintains a bridge between the logical data management layer (Logical
data type) and the semantic data management layer (ISO item). The ability to manage the links between
the two levels of data management ensures the metadata retains a high quality over time. This also
ensures that you can easily catch and fix any de-synchronization between the two data layers.
Moreover, when data duplication is identified at the logical layer level, then a de-duplication policy
can be executed. For example, by allowing the definition of a shared concept to be applied to several
data assets in the logical layer.
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The table below highlights the rules that the add-on applies to manage the links between ISO items
and types of data assets.

ISO item
(Administered Item)

Data asset types

(Logical data types)

Relation between the data
asset types and the ISO
items

de-duplication policy

Data Element Data value Unique N/A

Data Element
Concept (D.E.C.)

N/A N/A N/A

Table Unique No de-duplication

Group of fields Unique No de-duplication

Complex Type Multiple

Used in one to many tables
and groups of fields

Based on the logical name of the Complex type
(exact matching)

Object Class

Domain Unique No de-duplication

Property Field or Association Multiple

Used in one to many tables
and groups of fields

Based on the logical name of the Property
(exact matching)

Value Domain Data type Multiple

Used in one to many fields

Based on the logical name of the Value Domain
(exact matching)

It is important to understand at which levels the add-on applies a data asset de-duplication process to
enable definition unification when needed (see next section).

2.5 Data asset de-duplication process
When the de-duplication process is applied to any type of field assets that are defined in a data model,
two fields with the same logical name will only generate a single 'Property'.
The de-duplication process uses an exact matching execution that is case sensitive. For example,
the fields 'age' and 'Age' are considered different fields. But if an 'age' field is located in two tables
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('Employee' and 'Company') and each field name is an exact match, then only one 'age' property is
created in the repository. This property is then linked to the two fields located in the two tables.

Special notation:

By default, de-duplication is not active. The decision on whether or not to activate the de-duplication process is
taken when the data model is configured in the repository. This decision is definitive for the related data model.
The 'De-duplication is active' configuration property becomes read-only once the data model is declared in the
repository.

When de-duplication is activated, D.E.C. (Data Element Concept) types of 'Administered Items' can
be used to collect the definition related to the association between a field (Property) and a table (Object
class). For instance, if an 'age' field exists in two tables ('Product' and 'Client') then the de-duplication
process generates the following Administered Items:

• Property 'age'

• Object class: Product

• Object class: Client

• D.E.C: Product-age and Client-age

The generic definition of 'age' is applied to the property and the additional definitions that are specific
to the 'Client' and 'Product' tables are attached to the related D.E.C.s.
De-duplication of other ISO items depends on the governance processes an organization needs to
enforce. For example, the de-duplication of tables cannot be done systematically. It is common to
declare tables with the same name in different data model domains. At the governance repository level
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either each of these tables is itself considered an 'Object' class, or a de-duplication is applied in an
attempt to unify the definition through a unique 'Object' class.

Special notation:

The de-duplication process currently does not support:

• Application to 'Field' and 'Complex types' using fuzzy matching.

• Application to 'Table', 'Group of fields', and 'Domain' types.

• Configuration of whether to execute de-duplication by asset type.

• A scope of multiple data models.

• Application based on Item definitions.

When you disable de-duplication at the data model level, it applies only to fields.

2.6 Data staging applied to the add-on repository
Data spaces are created to manage add-on repositories by contexts of use. For instance, a child data
space can be dedicated to manage the 'Administered items' related to a single data model or to prepare
a future version of the metadata definitions.

Special notation:

The data spaces are also used to track the history of data modification applied to the repository. For instance, it
is possible to create a 'Future version' child data space and then use a comparison of data spaces to oversee the
differences between the current data space and the future version in preparation.
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2.7 Metadata views
On the table 'Item', several data views are available to display the metadata either in the simplest way
(View Object class) or through the full list of metadata types (View all metadata).

When the de-duplication process is not applied, the simplest data view 'View Object class' is sufficient
to manage the metadata in most cases. The usage of the Data Element Concept is interesting when the
de-duplication process is used and then duplicate properties are detected. In this case, the duplicate
properties are defined in a unified way (one property only with one definition) and then more specific
definitions are provided in the context of each related Object classes, namely the associated Data
Element Concepts (link between the Property and an Object class). For instance, the property 'age' is
related to two different fields in the tables Client and Product. This property is defined by itself, and
then for the two related Data Element Concepts 'Client-age' and 'Product-age'.
The labels of the data hierarchy views are based on the logical labels of the items that come from the
logical data model. As illustrated later in this user guide, you must use a 'Universal name' to provide
a more meaningful label. This universal name is then displayed in parenthesis after the logical label.
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CHAPTER 3
Administered Item naming

This chapter contains the following topics:

1. Logical name

2. Universal name

3. Logical label

4. Selecting the type of item name for display
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3.1 Logical name
When the add-on creates Administered Items from a data model, their logical names are set
automatically. Depending on the type of the Administered Item, the logical name is based on one of
the policies described below.

Administered Item Data asset types

(Logical data
types)

Rules applied to fulfill the default name
automatically

Examples

Data Element Data value 'D.E.C. name' - 'Value Domain name' Person-name-String

Person-age-Integer

Data Element
Concept (D.E.C.)

N/A 'Object Class name' - 'Property name' Person-name

Person-age

Table Logical name of the table as known to EBX® Person

Group of fields Logical name of the group as known to EBX® MyGroup

Complex Type Logical name of the complex type as known to
EBX®

Address

Object Class

Domain Logical name of the group as known to EBX® Root

Property Field, Association Logical name of the field as known to EBX® name

age

linkProduct

Value domain Data Type Name of the data type as known to EBX®.
When the data type is an enumeration the postfix
[Enumeration] is added

Integer

String

Special notation:

The modification of an Administered Item's logical name is forbidden since it represents the link with the
underlying data model. However, it is possible to display a 'Universal name' instead of the logical name (see the
next section).

In the example below, a unique 'age' property is created since the logical names of the fields are exactly
the same. From a governance point of view, the 'age' property is described by itself, and each 'age'
field related to a table is also described through Data Element Concept names.
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This ability to unify the 'age' definition enables metadata optimization. With help of the 'Data Element
Concept name' it is possible to provide an additional definition of 'age' in the context of every table.

Special notation:

You can deactivate the de-duplication process (see previous section). A configuration property determines
whether de-duplication is active or inactive.

Table logical name Field logical name Property name Data Element Concept name

Customer age Customer-age

Employee age

age

Employee-age

In this second example, the logical names of the fields are different. This means that two different
properties are created. It is no longer possible to create a shared definition for the concept of 'age'.

Table logical name Field logical name Property name Data Element Concept name

Customer age age Customer-age

Employee Age Age Employee-Age

In the UI governance repository, when properties have the same name with different case, then a suffix
is added to distinguish them. This suffix is the property identifier. For instance, in the example above,
the display can be 'age[111]' and 'Age[123]' considering that '111' and '123' are the related identifiers.
This naming convention is also used when the de-duplication process is deactivated in order to
distinguish between Administered Items with same logical name.

3.2 Universal name
At times an Administered Item's 'Logical name' may lack enough context to make it truly useful.
However, due to its required link to the underlying data model, you cannot modify the 'Logical name'
property. The 'Universal name' property can fill this gap by providing additional information that
enriches the item's context.
Upon automatic item creation, the 'Universal name' inherits from an item's 'Logical name' property.
However, you can override this value to use a 'Universal name'. This naming convention holds true for
automatic creation of D.E.C. (Object class — Property) and Data Element (D.E.C. — Value Domain)
composite Administered Items. Take for example, the D.E.C. illustrated below.
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The table below shows default naming applied by the governance repository for the 'EMPL01' table
and 'NameEmp' field. Additionally, it shows the result of enriching the information manually, or by
using the built-in 'Reset' option. The following sections discuss these methods in further detail.

Updating the 'Universal name' applied to atomic Administered
Items
The following example shows an Administered Item that is a type of 'Property'. By default, the
'Universal name' inherits from the 'Logical name'.

To provide additional information, click the small gray icon next to the 'Universal name' property to
overwrite inheritance and enter a new name.

Updating a 'Universal name' applied to composite Administered
Items
The following example shows a D.E.C. which is a type of composite Administered Item based on an
Object class and a Property. As shown below, the 'Universal name' inherits from the 'Logical name'
of the two related Administered Items.
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You can click the 'Reset' button to override default behavior and automatically compute the 'Universal
name' based on the composition of the Administered Items' 'Universal names'. In this example the
'Brand-Identifier' Data Element Concept 'Universal name' is 'Brand-identifier[4]'.

Alternatively, you can manually override both types of inheritance and customize the 'Universal name'.

Special notation:

You must provide a universal name when manually creating administered items. It is part of the process of
governance repository optimization.

Like the logical name, the universal name is not localized by language. Indeed, the universal name is a business
translation of the logical name into a meaningful term. To provide names and definitions by languages, the
"Definition" tab is used. The definition is done by languages and any other types of contexts.

3.3 Logical label
The logical label is retrieved directly from the logical data model. It is displayed for information only
on the Administered Item's main display tab. It is also the information attached to the DMA context
in the 'Context naming definition' tab.
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3.4 Selecting the type of item name for display
The data hierarchy views and other parts of the add-on repository UI can be configured to display
either an Administered item's 'Logical name', 'Universal name' or 'Logical label'. By default, the
'Logical label' is used.
You can refer to 'Configuring user preference' section to see how to select the type of name to display.
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CHAPTER 4
Administered Item identifier

This chapter contains the following topics:

1. Understanding identifiers

4.1 Understanding identifiers
The add-on automatically computes a unique identifier for every Administered Item. This identifier
is based on a numeric value, incremented by one.
From a technical point of view, an Administered Item's primary key is a composite data structure that
includes an object identifier (auto-incremented by one) and the unique identifier of the current EBX®
repository. This means that you can export and import Administered Items from one repository to
another without risk of conflict between the primary key values.

Special notation:

The ISO-IEC 11179 standard describes a composite data structure for the Administered Item identifier that refers
to additional information such as the identification of the registry authority and a version identifier. This data will
be added in a future version of the add-on.

Version management of the Administered Items is already performed by use of data spaces in EBX® (refer to
the EBX® documentation). This allows you to create branches of repository versions. You can then compare
versions and manage version merging over time.
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CHAPTER 5
Administered Item life-cycle

This chapter contains the following topics:

1. Administered Item creation

2. Administered Item deletion

3. Administered Item registration status

4. State of the Administered Item

5. Item Visibility

6. Workflow and additional treatments

5.1 Administered Item creation
You can create Administered Items:

• Automatically through an introspection of your data models known in EBX®. This process allows
you to populate—using a single action—the governance repository and start metadata enrichment.
At any time, you can control metadata alignment with the underlying data models. When the data
models evolve (tables and fields modification, deletion and creation), you can create a quality
report of the missing and orphan metadata. The same control is applied in case metadata has been
deleted from the governance repository or created without any reference to a data model.

• Manually when the data model is not available. In this process, the add-on is used as a 'Business
requirement' tool. A data modeler can design the logical data by reusing the metadata definition.
When you add this data model to EBX®, you can synchronize between manually created
Administered Items and the logical data elements. This ability to re-synchronize the business
requirements with the actual data models encourages an efficient, collaborative workflow between
business users and data modelers.

The following sections describe how to automatically and manually create Administered Items.
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Automatically creating an Administered Item
The 'Create Administered Items', 'Refresh Administered Items' and 'Validate Administered Items'
services allow you to manage automatic creation, re-synchronization and control of the alignment
between the metadata and the underlying logical data models.

Manually creating Administered Items
To manually create an Administered Item:
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• Navigate to 'Administered Item' → 'Item' table and from the 'Actions' menu select 'Create a record'.

• Fill in the required fields. The 'Is table' or 'Is field' options display depending on whether you
create an Object Class or Property, respectively. The corresponding drop down list allows you to
select a table, or field path without having to enter the node's full path in the logical data model
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by hand. Note that this functionality is only available if you haven't already created Administered
Items automatically from this data model.
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• After saving and closing, the new item displays.
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As shown below, you can determine how an item was created and its current state by viewing its
'Administrative' tab.

Administered Items creation modes

The 'Brand' metadata has been created automatically and is
aligned with the underlying logical data model.

The 'MyManualItem' metadata has been created manually and
is not aligned with any underlying data model.
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You can synchronize a manually created Administered Item (Eg. 'MyManualItem) with its data model
by running the 'Synchronize metadata' service. Each manually created Item's 'Actions' menu contains
this option if you haven't run this service on the Item, and its 'State' is 'Unaligned Data Model'.

Special notation:

In the current version of add-on, manual creation of an Administered Item does not allow the user to describe the
relations held by an 'Association' type property. The 'Association' property can be created but will not appear in
the 'Relation' tab. You need to synchronize this association with an actual association type data element in a data
model to get its full definition.

To enforce the parent relation between Administered Items, you have to use the 'create record' service on the
Items data hierarchy view rather than the 'cross icon' at the table level. For instance, if you want to create an
'Age' property that is the child of the 'Employee' Object Class, you have to use the 'Create record' service from
the 'Employee' node (data hierarchy view).

5.2 Administered Item deletion
You can logically delete any Administered Item by using the 'Set deleted' service. A purge service
is used to physically delete all Administered Items with a 'deleted' state. See section 10, 'Registry
synchronization' for more information about the Administered Item deletion.
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5.3 Administered Item registration status
Registration status defined in the ISO-IEC 11179 standard allows you to track an Administered Item's
publication level. The table below highlights possible status values as defined in the ISO-IEC standard.

Registration

status value

Description (ISO-IEC quote)

Candidate The Administered Item has been proposed for progression through the registration levels.

Recorded The Administered Item has all its mandatory metadata attributes completed.

Qualified The Administered Item had a 'Recorded' registration status and the Registration Authority confirms that
mandatory metadata attributes are complete and conform to applicable quality requirements.

Standard The Administered Item with the 'Standard' status had a 'Qualified' registration status and the Registration
Authority confirms that the Administered Item is of sufficient quality.

Retired The Registration Authority no longer recommends the Administered Item for use.

You can enrich the base set of status values with additional values by creating a new record in the
'Registration status' table. This table is located in the 'Reference data' domain.
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5.4 State of the Administered Item
Every Administered Item has a state value that indicates its level of quality. The table below highlights
the possible values.

State value Description

Data aligned The Administered Item is associated with a data asset in the EBX® data models.

Unaligned Data
Model

The Administered Item is not associated with a data asset in an EBX® data model.

You cannot change an Administered Item's state value manually. Its value is computed by the add-
on when the Administered Item is created and when synchronization between the glossary repository
and the data model executes.
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The 'View misaligned metadata' view allows you to track all Administered Items with the 'Unaligned
Data Model' state value.

5.5 Item Visibility
You can hide any Administered Item from the data views. Only administrators can update the 'Is
hidden' configuration property that determines visibility. This valuable feature allows you to hide
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technical metadata or business metadata that isn't useful for governance. You can also restrict the
visibility of any Administered Item to one to many user profiles.
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The 'TIBCO EBX® Information Governance Add-on' data space is located under the EBX®
'Administration' tab → 'Metadata management' and allows you to activate/deactivate the process to
hide and to filter Administrated Items by user profiles.

5.6 Workflow and additional treatments
You can configure a trigger extension (Java class) on the 'Administered item' table. The Java class is
then triggered during the Administered item modification and creation processes.
This trigger extension can perform any type of action: workflow execution, rules execution, data
transfer, etc.
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To declare a trigger, please refer to 'Configuring trigger on Administered Item' section.

Special notation:

By using the collaborative workflow in EBX®, it is easy to configure governance processes that will enforce a
suitable life cycle for the registration status (refer to EBX® documentation).

Special notation:

When an Administered Item is created, its Registration status value is automatically set to 'Candidate'. When an
Administered Item's Registration status moves to 'Standard', then its effective date is automatically fulfilled with
the current date.
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CHAPTER 6
Administered Item description

This chapter contains the following topics:

1. Overview of descriptions

2. Defining a context

3. Default context

6.1 Overview of descriptions
An Administered Item description represents the repository's core data. You complete descriptions
by adding one or more contexts and any associated synonyms. You can create these contexts in the
'Context' table. In addition to a description, you can associate a context with a language, country,
criterion, and parent context.
When adding information to a 'Definition' field, you can link to other data in the repository. For
example, you could add a link to the responsible party to contact with questions about an Administered
Item. This link opens the 'Party' record and displays contact information. Each link consists of a 'Tag'
combined with the identifier for the record to link. The input to link to a record in the 'Party' table with
an 'Identifier' of 0000001 would be—'pa1'. The following table lists each 'Tag' and the table it links to:

Tag Links to

ai The 'Item' table.

cx The 'Context' table.

cr The 'Criterion' table.

pa The 'Party' table.

dr The 'Data repository' table.

dm The 'Data model' table.

The following steps demonstrate adding a tag to a 'Description' field in an Administered Item's
'Definition' tab:
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• Before adding the 'Definition' label and text, you may have to click 'Edit', or 'Refresh' if you've
changed the context.

• After entering a definition label, you can add a tag to the descriptive text by clicking a tag below
the text box that corresponds to the table you want to link to. In this example, we are just adding
a simple sentence stating that we want to contact a certain party for more information.



Documentation > Information Governance Add-on Documentation > User Guide > Administered Item description

TIBCO EBX® Information Governance Add-on 45

• Once the table opens, click 'Insert' on the corresponding record. Note that you can insert multiple
tags at this point.
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• After saving, the link displays and as shown below, clicking on the 'Preview' icon opens the
associated record.

As illustrated below, the 'Brand-identifier' 'Data Element Concept' is documented with the help of
three contexts: 'US Marketing', 'US Sales' and 'DMA - Data Modeler Assistant'. They enable definition
of the 'Employee' concept from the marketing and sales points of view. The third context 'DMA - Data
Modeler Assistant' is automatically created and refreshed on demand from the information available
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in the data model that is designed from the EBX® DMA Data Modeler Assistant. You can create any
type of context.

Special notation:

The 'Refresh' button replaces the current context with the one you select, thus definitively overwriting the
current context. If you have more than one context and want to rearrange the context order, you can use the up/
down arrow on right. When the 'DMA' context is erased, you can create it again without having to refresh the
Administered Items. The DMA's information is retrieved-in real time-from the logical data model.

When you open a context, the following information is available:

Special notation:

A 'Definition's' short description is different from the 'universal name' that is defined to override the
Administered Item's default name. The definition explains the concept, as opposed to being just another name.
Conversely, a synonym or a 'universal synonym' allows you to declare other names for the Administered Item.
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The following table provides definitions for the documentation fields.

Documentation field applied to
an Administered Item

Definition

Context A context is mandatory when entering documentation for an Administered Item. A context can
be a language, a classification or any other concept that meets organizational needs. If different
contexts are not necessary, then a 'Default' context can be created and used systematically by
all descriptions.

Definition The definition is based on short and long descriptions. The short description is used when
definition lists display and labels are used in data views.

The definition is localized by languages registered with EBX®. These do not need to be the
same as the languages that are defined through the contexts. For example, it is possible to
define 'Spanish', 'Portuguese', 'English and 'French' contexts, whereas the definition for each
of these contexts is provided in the two languages used to manage the data in EBX®, for
example, the defaults, English and French.

Any definition text can integrate "tag links" to refer to any information in the governance
repository. For instance, the text 'Please refer to the item ai3392' is automatically translated into
'Please refer to the item 3392' (the hyperlink is computed thanks to the key word 'ai'). A list
of ready-to-use key words is available to reach any information in the governance repository
(refer to the 'Tag link' table in the 'Reference data' group).

Related definition The definition can refer to the definition of other Administered Items.

Synonym The short description can be used to explain how the synonyms are derived, from where they
have been sourced, etc. The long description should be a separated list of synonyms. Since the
description is free text, an organization can define its own naming convention.

When synonyms do not need to be localized, use the 'universal synonym' field.

Universal synonym A universal synonym is a term or phrase not dependent on a specific language.

Description Free text to provide additional documentation.

6.2 Defining a context
You describe a context through documentation, as shown below.
Any type of context can be created. The context could be related to a certain language or a
classification. Contexts can be linked with each other through a 'Parent' relation.
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Here is an example for the 'Marketing' context.
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The table below gives a definition for each documentation field in the context.

Documentation field applied to
a Context

Definition

Name Any naming convention can be used.

Description Describes the context. This description is localized by language.

Any description text can integrate "tag links" to refer to any information in the governance
repository. For instance, the text 'Please refer to the item ai3392' is automatically translated into
'Please refer to the item 3392' (the hyperlink is computed thanks to the key word 'ai'). A list
of ready-to-use key words is available to reach any information in the governance repository
(refer to the 'Tag link' table in the 'Reference data' group).

Language When the context is related to a language, this selection chooses the language. These are not
the locale that are used by EBX® for data management. They come from a reference data table
in which any language can be declared.

Classification and Group The classification scheme used to organize Administered Items can also be used to define
a context. For example, a classification can define the business units of an organization
(Marketing, Sales, Manufacturing).

Initially, these classification items are used to group Administered Items in a desired way.
It can also be useful to reuse these items to define the contexts on which the glossary is
structured. This means that you can provide a definition of a concept such as a 'Client' in
each of the three contexts: 'Marketing', 'Sales' and 'Manufacturing'. If a universal definition is
necessary, a fourth context can be created with a name such as 'Corporate'.

Parent context A context can be linked to another context through a 'Parent' relationship.

6.3 Default context
When the Administered Item is automatically created from a data model a default context is set up.
The name of this context is "[ON] DMA". The label and description that exist in the logical data
model are then copied in this context. You cannot change the context information "[ON] DMA" since
it is refreshed during the synchronization of the governance repository with the logical data models.
However, it is possible to copy and paste this context to another context-inside which it is possible
to modify the label and description.

Special notation:

Round-trip function to re-align the logical data model's labels and descriptions with a new context coming from
the governance repository.
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CHAPTER 7
Administered Item and party

management
This chapter contains the following topics:

1. Parties and their roles

2. Exporting a RACI matrix

3. Party inheritance

7.1 Parties and their roles
The repository allows you to define any type of party and any type of role played by a party in relation
to Administered Items. In addition, you can use default images provided by the add-on, or associate
custom images with parties, roles and types. When viewing an Administered Item's 'Party' tab, items,
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associated parties, and roles display in a RACI style matrix. As shown below, this view clearly defines
actors, roles and responsibilities.

When viewing the Party tab, you can use the Display Parties horizontally checkbox to change
display of the matrix. By default the box is checked and the parties display horizontally across the top
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row. Unselecting the box displays the parties vertically in the first column of the matrix. The following
image shows an example of the display options:

Party management utilizes a fully generic data structure and allows you to define parties that meet
any scenario:

• Examples of types of parties: Organization, Authority, System, Application, Business Unit,
Region, Report, etc. A type of party can also refer to a system or an application (such as a report
or a database).

• Examples of roles: Owner, Consumer, Provider, User, Transformer, etc.

An Administered Item can be associated with an unbounded number of parties playing a role in relation
to it. For example, you could declare the following statements on any Administered Item:

• "System" that is the "Owner",

• "Application" that is the "Provider",

• "Region" that is the "User",

• etc.

Based on this kind of party and role management system, you can describe any stakeholder's type of
involvement with an Administered Item.

7.2 Exporting a RACI matrix
The add-on allows you to export a matrix to the Excel file format. To export a matrix:

1. In one of the following locations, open the Actions menu and under Information Governance
select Excel export:

• The Information Governance dataset.
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• The Data model table located at Information Governance > Administered Item > Data
model.

2. On the configuration page:

• Select Matrix as the export type.

• Use the Export parties to the property to specify how the matrix displays in the exported file.

3. After selecting Export, you will be prompted to open or save the file.
The following image shows an example of an exported file:

7.3 Party inheritance
When enabled by an administrator, properties can automatically inherit parties and roles from parent
object classes. This inheritance only applies if the property doesn't already have a defined role/party.
Additionally, inheritance doesn't set the property's role and party values; it only displays the closest
parent's values. For instance, a property could have the following path: /root/item/address/name. The
'name' property would inherit the values from the 'address' group.
To enable party inheritance:

• Navigate to 'Administration' > 'TIBCO EBX® Information Governance Add-on' > 'User
preference'.

• Enable the 'Property inheritance active' property.

Special notation:

The EBX® data hierarchy views allow you to configure different views for querying data through the
relationships between Administered Items; the parties and the roles played by the parties.
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CHAPTER 8
Administered Item relationships

This chapter contains the following topics:

1. Linking Administered items

8.1 Linking Administered items
Any Administered Item can be linked to others. Every link is described with a link type such as:
semantic relation, potential duplicate, same, uses, nested, direct association, indirect association, etc.
For example, these statements can be easily declared to any Administered Item:

• "Employee" is in a "Semantic relation" with "Employer".

• "Client" is a "Potential duplicate" of "Customer".

• "product organization" is in "direct association" to the "Manufacturing Unit".

• etc.

Special notation:

The EBX® data hierarchy views allow you to configure different views for querying data through the links
between the Administered Items.
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CHAPTER 9
Registry synchronization

This chapter contains the following topics:

1. Data model declaration

2. Services list

3. Services applied to a data model

4. Services applied to the Administered Items (record level)

5. Services applied to the Administered Items (table level)

9.1 Data model declaration
In order to create and maintain Administered Items you need to declare a data model, and specify
a data space and data set based on the data model. The add-on bases Item creation on the data set
contents. Additionally, the add-on synchronizes the governance repository using this data set. If you
delete the data set, main EBX® Information Governance Add-on features will continue to work for
other data sets based the data model. However, other features, such as TIBCO EBX® Graph View
Add-on and TIBCO EBX® Insight Add-on integration will not.
To declare a data model:

• Navigate to 'Administered Item' > 'Data model' and create a new record.

• Fill in the required fields. If you would like more information about a particular field, open the
tool tip by hovering your cursor over the property name and clicking the '?' icon.

• After saving and closing, the data model is available to the add-on.

Special notation:

Migration of the governance repository from a pivot data set to another, provided the underlying data model is
the same.
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9.2 Services list
The table below gives the complete list of services used to manage and synchronize the registry with
the data model.

Table on which the service is
available

Service name

Create Administered Items

Delete Administered Items

Refresh Administered Items

Validate Administered Items

Export Excel

Data model

Import Excel

Set deleted

Recursively delete

Administered Item (Record
level)

Set undeleted

Recursively delete Administered Items with no data model referenceAdministered Item (Table
level)

Purge deleted Administered Items

9.3 Services applied to a data model
To access the services covered in this section:

• From an Information Governance data set, select 'Administered Item' > 'Data model'.
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• You can find the data model services under the 'Actions' menu > 'Information Governance'. Select
a data model's checkbox before applying a service.

Screen shot updated

Create Administered Items
This service automatically creates all the Administered Items that are identified in the underlying data
model.
When the service is used to re-create the Administered Items, the following procedure is applied:

• Existing Administered Items are refreshed.

• Missing Administered Items are created.

The results report is as follows:

Result Description

Number of created records Number of new Administered Items created.

Number of refreshed and merged records Refreshed:

• The Administered Item already exists.

Merged:

• A data asset (from the data model) matches with an existing Administered Item,
then it is merged with it

Number of invalid records Normally, the occurrence of invalid records isn't allowed. It could happen in case of
fatal error in the underlying EBX® data model used to create and synchronize the
Administered Items.

Total number of processed records This is an estimation based on the following computation rule: Number of created
records + Number of refreshed and merged records + Number of wrong records.
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Delete Administered Items
This service is used when you need to reset the entire repository's contents for a specific data model.
All the Administered Items in relation with the data model are then deleted.
The results report is as follows:

Result Description

Number of deleted records Number of Administered Items were deleted.

Refresh Administered Items
This service updates all information sourced from the underlying data model and applies to valid
Administered Items that already exist. This service does not create any potential missing Administered
Items.
The results report is as follows:

Result Description

Number of validated, refreshed, and
merged records

Validated, Refreshed:

• The Administered Item already exists.

Merged:

• A data asset (from the data model) matches with an existing Administered Item,
then it is merged with it.

Number of items which are not aligned
with the data model or not defined as
metadata

Normally, wrong records must not occur. However, this could happen in the case of
a fatal error in the underlying EBX® data model used to create and synchronize the
Administered Items.

Total number of processed records This is an estimation based on this computation rule = Number of validated-
refreshed records + Number of refreshed and merged records + Number of wrong
records.

Validate Administered Items
When an Administered Item is no longer associated with a data asset in the underlying data model, its
state changes to "No Data Model reference": field or table is deleted, or the data set is missing. When
the Administered Item is associated to a data set, its state value is 'Aligned'.
The results report is as follows:

Result Description

Number of invalid records Number of Administered Items which are not aligned with the data model or not
defined as meta data.

Total number of processed records This is an estimation based on this computation rule = Number of invalid records +
Number of valid records
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Export in Relational data
Note that you can only access this service in releases prior to GA 1.6.0. This service allows you to
export the Administered Items in a relational data set named 'Information Governance - export' at
the level of the reference data space (refer to 'Exporting the governance repository' section for more
information).

Export Excel
This service allows you to export Administered Items—those based on the selected data model—to
an Excel spreadsheet. After running the service the add-on displays a page that allows you to choose
from the options in the following table:

Property Description

Export type Specifies the type for this export. 'Full' includes all Administered Items and related
metadata. 'Light' exports only Object Class and Property Items, and includes basic
metadata. If you plan to re-import this information, you must only use the 'Light'
option.

Excel file type Specifies the exported file's Excel compatibility.

Context Defines the context used for this export.

Language Defines the language used for this export.

Default context The context used for the logical label and definition in the exported file's 'Global
view' sheet.

Default language The language used for the logical label and definition in the exported file's 'Global
view' sheet.

Note that the exported file's 'Is field' tab contains fields grouped by table to provide complete data
model documentation.
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Export PDF
When you execute the 'Export PDF' service, the add-on exports a PDF of the selected data model's
metadata definition. As shown below, you only need to specify the context, language to use in the
export, and whether to include the DMA definition in the export.

Notice that the following image reflects the settings shown above and displays the Manufacturing
and DMA context definitions. Additionally, the exported file highlights the Primary and Foreign Key
fields for easy identification:
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Import Excel
This service allows you to import Administered Items from an Excel spreadsheet. You can only import
from a spreadsheet that was previously exported using the 'Light' option.

9.4 Services applied to the Administered Items (record
level)

Set deleted
The selected Administered Item is logically deleted. This means that its 'Is deleted' and 'Is hidden'
properties are set to 'Yes'. The Item is no longer displayed (expect for the Admin user) and can be
purged by the 'Purge deleted Administered Items' service available on the 'Administered Item' table.

The Admin user can see Items that have been logically deleted (names are shown in strikethrough
text). The 'Is deleted' and 'Is hidden' properties of these Items are forced to 'Yes'.

Recursively delete
The selected Administered Items and their related items are physically deleted (deletion on cascade).
The relation between the Administered Items used for the deletion on cascade is as follows:

• Object Class or Property is deleted → related D.E.C. and related Data Element are deleted as well.

• Value Domain or D.E.C is deleted → related Data Element are deleted as well.
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Set undeleted
You can undo the logical deletion of an Administered Item. The Item will be displayed again and its
'Is deleted' and 'Is hidden' properties are forced to 'No'.

Synchronize metadata
You can use this service to synchronize manually created Items with their data model. Note that
visibility of this service depends on whether you created the Item manually and whether its state is
considered 'Unaligned data model'. As long as these two criteria apply, you can run this service from
an open Administered Item's 'Services' menu > 'Information Governance'.

9.5 Services applied to the Administered Items (table
level)

Recursively delete Administered Items with no data model
reference
Delete all invalid Administered Items and their related items.
With compact Administered Items, the service deletes the invalid part only. For example, here are two
fields with the same logical name:

• Person-name

• Customer-name

The "name" property is not deleted if the user deletes the Customer-name only.
When two or more fields with the same name exist in the data model then only one Property is created
(de-duplication mechanism). When the data model changes and a field is removed then the Property
is not deleted and only its related Administered Item is deleted.

Purge deleted Administered Items
This service physically delete all Administered Items with the property 'Is deleted' = 'Yes'.
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CHAPTER 10
Permissions

Since the governance repository is a standard EBX® repository, all permission configuration provided
by the tool is available. See the EBX® documentation for further information.
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CHAPTER 11
Other governance functions

All data governance functions provided by EBX® can be applied to the metadata used in the
governance repository. As already mentioned in the overview, the metadata benefits from actual master
data governance. Among the many features available in EBX®, some examples include:

• collaborative workflows,

• version management and data staging using the data spaces life cycle,

• data matching,

• data indicators or reporting,

• fuzzy search,

• audit trails for all operations,

• import and export of data in XML, CSV and XML format,

• geographically distributed repositories (D3),

• etc.
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CHAPTER 12
Governance repository data

architecture
This chapter contains the following topics:

1. Administered Item

2. Context

3. Classification

4. Party

5. Rules

6. Reference data

7. History

12.1 Administered Item

Data repository
A Data repository allows you to group one to many data models that are related to a unified business or
technical domain. For instance, the 'Human resource' Data repository contains all data models related
to a company's HR systems.

Property Definition

Identifier Identifier used as a tag link reference.

Name Name of the data repository.

Description Description of the data repository.

Type A Data repository is associated with a type that has been defined in the ''Repository type" table,
located in the 'Reference data' domain. When associating a repository with a type does not provide any
immediate benefit, you can set this property to 'Unknown'. You can extend the list of types to meet your
specific business needs by creating new records in the 'Repository type' table.

Last refresh date Date of the latest refresh executed at the data model level in the Data repository.
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Data model
A Data model is the main entry-point for the EBX® Information Governance Add-on. It contains
the metadata the repository collects, and enriches and governs through the governance processes. It
corresponds to a data model in EBX®.

Property Definition

Data identifier Identifier used as a tag link reference.

Data model The published data model to use as the basis for Administered Item management.

Data space The data space containing the data set from which you can create and synchronize Administered Items.

Caution: The data space and data set should be stable throughout the governance repository life-cycle. If
either are removed, or deleted you will still have access to the data model, but other features like links to
data value will not be available.

Data set The data set from which you can create and synchronize Administered Items.

Caution: The data space and data set should be stable throughout the governance repository life-cycle. If
either are removed, or deleted you will still have access to the data model, but other features like links to
data values will not be available.

Data repository A Data model can belong to one Data repository. The ability to group Data models by Data repository is
not mandatory to use the add-on.

Description Description of the data model.

Data nature The 'Data nature' property allows you to declare the underlying characteristics that the Data model is
designed around. All Administered Items created for this Data model will inherit their 'Data nature' from
this value. When a Data model contains data that varies in nature, either the 'Data nature' property is
set to 'All nature' or 'Unknown', or with one that is most commonly used in the data model. It is also
possible to extend the list of natures by creating new records in the 'Date nature' table.

De-duplication is
active

You decide whether or not to activate the de-duplication process when the data model is configured
in the repository. This decision is definitive for the related data model. The 'De-duplication is active'
configuration property becomes read-only once the data model is declared in the repository.

The de-duplication process is applied on fields defined in a data model. This means that only one
Property is generated when two fields have the same logical name.

The de-duplication process uses an exact matching execution that is case sensitive. For example,
the fields 'age' and 'Age' are considered different fields. But if an 'age' field is located in two tables
('Employee' and 'Company') and each field name is an exact match, then only one 'age' property is
created in the repository. This property is then linked to the two fields located in the two tables.

When the de-duplication is activated, D.E.C. (Data Element Concept) types of Administered Items can
be used to collect the definition related to the association of a field (Property) and a table (Object class).
For instance, if an 'age' field exists in two tables ('Product' and 'Client') then the de-duplication process
will generate these Administered Items:

• Property 'age'

• Object class: Product

• Object class: Client

• D.E.C: Product-age and Client-age

The generic definition of the age is applied to the property and the additional definitions that are specific
to the client and the product are attached to the related D.E.C.s.
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Property Definition

Last refresh date Date of the last refresh of Administered Items applied to the data model.

Item - 'Main' tab

Property Definition

Data repository The Data repository containing the Data model.

Data model Data model that owns the Administered Item.

Data nature The 'Data nature' of the Administered Item is inherited from the 'Data nature' property defined at the
Data model. You can change this value at the Administered Item level.

ISO type ISO-IEC 11179 type such as Object Class, Property, Value Domain, Data Element Concept, Data
Element.

Logical data type Logical data type such as Table, Field, Data value

Logical name The logical name of the Item comes from the logical data model. This name cannot be modified
manually. It must be identical to the one coming from the data model. It is not localized by languages
since this is a unique logical name designated in the data model. It is automatically generated during the
synchronization process between the data model and Administered Items.

For the composite Administered Items the logical name is based on the logical names of the two related
Administered Items. The composite Administered Items are the D.E.C. (Object class - Property) and the
Data Element (D.E.C. - Value Domain).

Logical label The Item's logical label comes from the logical data model. This is the label used by language to identify
the Item in the data model.

Universal name The 'Universal name' property is required and inherits from the logical name. You can change the
inherited value to clarify naming and provide a more meaningful value. The universal name is not
localized by languages since there is a direct relation with the logical name. To provide names in
different languages, the "Context naming definition" is used. The universal name is not automatically
supplied by the synchronization process between the data model and Administered Items. It is provided
by a governance repository's administrator.

Composite Administered Items' universal name is based on the composition of the related Administered
Items' universal names. The composite Administered Items are the D.E.C. (Object class - Property) and
the Data Element (D.E.C. - Value Domain). The 'Reset' button automatically retrieves the name based on
the two related universal names. You can use the 'Freeze' property to protect a composite Administered
Item's universal name value from an automatic refresh by the add-on during repository synchronization.

Freeze universal
name

If 'True': The universal name is no longer automatically synchronized with the names of the two related
Administered Items.

If 'False': The universal name is automatically synchronized with the names of the two related
Administered Items.

The 'undefined' value is considered as 'False'.
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Item - 'Administrative' tab

Property Definition

Item identifier group

Data identifier The Administered Item's unique identifier. In the current add-on version the identifier value is
automatically incremented by one. In a future version other data could participate in the 'Data identifier'
property's computation.

From a technical point of view, an Administered Item's primary key is a composite data structure that
includes an object identifier (auto-incremented by one) and the current EBX® repository's unique
identifier. This means that you can export and import one repository's Administered Items to another
without risk of conflict between the primary key values.

Item information group

Creation date Automatically provided when the Administrated Item is created.

Creation mode When the Administered Item is automatically created by the synchronization process with a data
model, the 'Creation mode' property displays as 'Automatic'. Otherwise, the 'Creation mode' property is
'Manual'.

Last modification
date

Automatically provided every time a modification occurs on the Administered Item.

Effective date When an Administered Item is created, its Registration status value is automatically set to 'Candidate'.
When an Administered Item's Registration status moves to 'Standard', then its effective date is
automatically populated with the current date.

State If the state value is 'Aligned', it means that the Administered Item can be associated to a data model
element. If there is a misalignment, the state value is "No Data Model reference". Other states can exist
depending on the governance process to be applied.

Registration status The registration status is defined in the ISO-IEC 11179 standard. It lets you track an Administered Item's
publication level. The following list highlights the possible status as defined in the ISO-IEC standard.

• Candidate: The Administered Item has been proposed for progression through the registration levels.

• Recorded: The Administered Item has all its mandatory metadata attributes completed.

• Qualified: The Administered Item had a "Recorded" registration status and the Registration
Authority confirms that mandatory metadata attributes are complete and conform to applicable
quality requirements.

• Standard: The Administered Item with the "Standard" status had a "Qualified" registration status and
the Registration Authority confirms that the Administered Item is of sufficient quality.

• Retired: The Registration Authority no longer recommends the Administered Item for use.

Approval Percentage of the approval process achieved.

Deployment Percentage of the deployment process achieved.

Quality Percentage of the quality process achieved.

Additional attribute Unrestricted additional information that can be added in the format of 'Meaning - Value'.
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Property Definition

Extended attribute Controlled additional information that can be added in the format of 'Meaning - Value'. The 'Meaning'
field allows you to select a table, and the 'Value' field to choose a record from the selected table. The
list of the tables and fields for the selection is declared in the reference data domain, 'Extended attribute
tables'.

Application The item can be linked to one to many applications.

Confidentiality The item can be attached to a level of confidentiality.

Maintenance rules The item can be linked to one to many maintenance rules.

Is deleted item When the Administered Item has been logically deleted the 'Is deleted' property is set to 'Yes', otherwise
its value is 'No'

Hidden item You can hide any Administered Item from data views. The 'Is hidden' configuration property can be
updated by the administrator profile. This feature is useful when you want to hide technical metadata
or business metadata that isn't meaningful for governance. Under the EBX® Administration tab, the
'TIBCO EBX® Information Governance Add-on' data space allows you to activate/deactivate the
process to hide the Administrated Items by user profiles.

View by only You can restrict the visibility of any Administered Item to one to many user profiles. Under the EBX®
Administration tab, the 'TIBCO EBX® Information Governance Add-on' data space activate/deactivate
the process to filter the Administrated Items by user profiles.

Item - 'Physical' tab
Depending on the selected Item, this tab displays one of the groups described in the following sections.
Is Data Element Concept
A 'Data Element Concept' (D.E.C.) is the association between an 'Object Class' and a 'Property'. This is
not similar to a field in a table because a property can be associated with many tables. For instance, the
'Employee', 'Client' and 'Company' tables can each have an 'age' field. In this case, the 'age' property
is linked to the 'age' fields in each of the three tables.

Property Definition

Object Class The Object class used to define the D.E.C.

Property The Property used to define the D.E.C.

Used in Data
Element

The list of Data Element(s) that relies on this D.E.C.

Is Data Element
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A 'Data Element' is the actual value of a data. A 'Data Element' is used as an example to enrich
the definition of an ISO item. A 'Data Element' exists as the link between a 'Data Element
Concept' (D.E.C.) and a 'Value Domain'.

Property Definition

Data Element
Concept

The D.E.C used to define the Data Element.

Value Domain The Value domain used to define the Data Element.

Data exemplary This is an example of data value (first record in the table used as example).

Is Object Class
An 'Object Class' is a representation of a composite data structure such as a business object or a group
of related information.

Property Definition

Used in Data Element
Concept

List of Data Element Concepts that use this Object Class.

Is Property
A 'Property' is an atomic item (field or association). The combination of a property with an 'Object
Class' represents a 'Data Element Concept'. A property can be associated with many fields with the
same name in different tables. For instance, the 'Name' property is linked to the 'name' fields that are
located in the 'Employee', 'Supplier' and 'Partner' tables.

Property Definition

Used in Data
Element Concept

List of Data Element Concepts that use this Property.

Used in Data
Element

List of Data Elements that use this Property.

Is Value Domain
A 'Value Domain' is either an atomic data type (integer, string, etc.) or an enumeration that provides
a list of possible values for a 'Property'.

Property Definition

Used in Data
Element

List of Data Elements that use this Value Domain.

Is table
A table as defined in SQL. With the semantic data management mode in EBX®, a table's data structure
can be a complex data type that includes multi-occurrence fields.
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Unlike for the block of information "Is field", the "State" field is not used since the current version
of the add-on considers that an Object Class is linked to one "Table" at maximum. Then the state at
the level of the Object Class is sufficient.

Property Definition

EBX® table The corresponding table in the logical data model.

EBX® group The group where the table is localized.

Identifying properties List of the properties that constitute the primary key.

Table: linked to the table content

Object class: linked to the administered item

Property: linked to the administered item that correspond to the foreign key

Relation

Use when a table holds
fields that are foreign
keys

The cardinality information is retrieved from the logical data model in two different ways:

• When a direct Foreign key is used, cardinality is retrieved from the 'Information' property attached
to the foreign key field. You must establish a naming convention to be sure that the information
is used to describe the cardinality links on both sides of the association. For instance, between a
'Client' and 'Product', the foreign key field in the 'Client' table should have a definition with the
following format: 'Product(1,*), Client(0,*), if the association means that a 'Client' can have 1
to many Product(s), and it is permitted to have Product not yet sold. You can define any naming
convention depending on the preferred direction for reading the cardinality links between the two
tables.

• Using an Association field inherits the cardinality directly from the association level.

Information Retrieved from the logical data model in the 'Information' attached to the table.

Is field
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Atomic data with a simple data type: integer, string, etc. or a complex data type.

Property Definition

EBX® table The corresponding table in the logical data model.

EBX® group The group where the table is located

EBX® field The logical name of the field with its path in the table.

Physical data type The field's data type.

Associated D.E.C The list of D.E.Cs that use the property associated to this field.

Is primary key Boolean value that is retrieved from the logical data model.

Is foreign key Boolean value that is retrieved from the logical data model.

Linked to the
Administered Item

In case the field is a foreign key it gives the link to the related Administered Item.

Information Retrieved from the logical data model in the 'Information' attached to the field. In the case that
the field is a foreign key you must establish a naming convention to be sure that the information
property is used to describe the cardinality links on both sides of the association. For instance,
between a 'Client' and 'Product', the foreign key field in the 'Client' table should have a definition
with the following format: 'Product(1,*), Client(0,*), if the association means that a 'Client' can have
1 to many Product(s), and it is permitted to have Product not yet sold. You can define any naming
convention depending on the preferred direction for reading the cardinality links between the two
tables. An alternative to using the information statement applied to a foreign key, is the 'Association'
concept (refer to EBX® documentation) that allows you to directly describe relationships.

Is not null Boolean value that is retrieved from the logical data model.

Is Part of uniqueness
constraints

Boolean value that is retrieved from the logical data model.

Is auto increment Boolean value that is retrieved from the logical data model.

Minimum occurrence The value is retrieved from the logical data model.

Maximum occurrence The value is retrieved from the logical data model.

State If the state value is 'Aligned', it means that the Administered Item can be associated to a data model
element. If there is a misalignment, the state value is 'Unaligned data model'. Other states can exist
depending on the governance process to be applied.

Comment: the 'State' field is needed because a single Property can be linked to one to many fields.
Each field holds a state to indicate its synchronization status in relation to the data model.

Min size of the field Integer value that is retrieved from the logical data model.

Max size of the field Integer value that is retrieved from the logical data model.
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Property Definition

Fixed size Integer value that is retrieved from the logical data model.

Max number of figures
for an Integer and
Decimal

Integer value that is retrieved from the logical data model.

Number of figures after
decimal for a Decimal

Integer value that is retrieved from the logical data model.

Default value The value is retrieved from the logical data model.

Input pattern The value is retrieved from the logical data model.

Computed value Boolean value that is retrieved from the logical data model.

Inherited field Boolean value that is retrieved from the logical data model.

History activated Boolean value that is retrieved from the logical data model.

Category The value is retrieved from the logical data model.

Is association
Association between two tables linked either directly or through a join table (refer to EBX®
documentation for a more in-depth explanation).

Property Definition

EBX® table The corresponding table in the logical data model.

EBX® group The group where the association is localized.

Association The logical name of the association as defined in the data model.

Linked Object class The object class that is reached by the association.

Minimum occurrence The minimum occurrence of the object class that is reached by the association.

Maximum occurrence The maximum occurrence of the object class that is reached by the association.

Information The value is retrieved from the logical data model.

Is data type
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Atomic data type (Integer, String, etc.) with facets for data validation (length, enumeration, etc.).

Property Definition

EBX® table The corresponding table in the logical data model.

EBX® group The group where the table is localized.

EBX® field The logical name of the field with its path in the table.

Data type Integer, String, etc.

Data format The value is retrieved from the logical data model.

Minimum length The value is retrieved from the logical data model.

Maximum length The value is retrieved from the logical data model.

Minimum value The value is retrieved from the logical data model.

Exclusive The value is retrieved from the logical data model.

Maximum value The value is retrieved from the logical data model.

Exclusive The value is retrieved from the logical data model.

Is enumeration Boolean value. The value is retrieved from the logical data model.

Permission value List of enumeration values when this data type is enumeration. This value is retrieved from the logical
data model.

State If the state value is 'Data Aligned', it means that the Administered Item can be associated to a data model
element. If there is a misalignment, the state value is 'Unaligned Data Model'. Other states can exist
depending on the governance process to be applied.

Is Domain
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Group of tables that allows you to organize a data model into domains and sub-domains of tables.

Property Definition

EBX® table Not used for the domain definition.

EBX® group The group corresponding to the domain.

Minimum occurrence The value is retrieved from the logical data model.

Maximum
occurrence

The value is retrieved from the logical data model.

Domain contain The link to show all Object classes and Properties (in this group and in the table of this group) which are
contained in this group.

Item - 'Definition' tab

Property Definition

Definition

Context Link to a context that is defined through the 'Context' table. Every definition is provided for a context
which could be a language, an organization, a classification or anything else. The context named "[ON]
DMA" is automatically created during the process of synchronization between the data model and the
Administered Items. It is used to collect all logical descriptions that exist in the data model, namely the
label and description by languages. This information is then stored in the 'Definition' field.

Definition The definition is based on a label and a description localized by language. It is important to distinguish
the languages used for information localization, and the languages used for creating contexts. For
instance, a 'Spanish' context is created to provide definitions that are relevant for this language that
covers many countries worldwide. But for this context, the definition are provided not only in Spanish
but also in English and Portuguese.

Related definition A link to other Administered Items that are considered meaningful and complement, or enrich the
current definition.

Synonym The synonyms can be provided by languages. In case of synonyms that are not reliant on any languages,
then the 'Universal synonym' property is used. Any naming convention can be used to provide the list of
synonyms. A best practice is to use the short description as an explanation of the synonyms origin and
the long description provides the list of synonyms with a comma as separator.

Universal synonym One to many synonyms that are not dependent on a language.

Description An additional description of the item.
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Item - 'Party' tab

Property Definition

Party

The Parties involved in this Administered Item.

Party A Party involved in the Administered Item.

Role The role the Party plays regarding the Administered Item.

Party type The type of the Party automatically displays depending on the selected Party.

Item - 'Property' tab

Property Definition

Property

List of all properties of the current Administered Item of type Object class.

Item - 'Also defined in' tab

Property Definition

Also defined in

List of all Administered Items for which the definition is related to the current Administrated Item.

Item - 'Other relation' tab

Property Definition

Other relation

List of the relations with the current Administered Items that are defined through the relation scheme

Item - 'Classification' tab

Property Definition

Classification

List of the classification related to the current Administered Items that are defined through the classification scheme
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Item - 'Rules' tab

Property Definition

Rules

List of the rules related to the current Administered Items that are defined through the rules scheme

Item - 'Graph' tab

Property Definition

Data graph

Graph view applied on the data model under governance

Item - 'Meta graph' tab

Property Definition

Meta Data graph

Graph view of the metadata

Item - 'Quality' tab

Property Definition

Quality

Display the quality indicators related to the Administered Item. The display is based on the dashboards configured in the TIBCO
EBX™ Insight Add-on

Item - 'Comment' tab

Property Definition

Comment

Display the comments related to the Administered Item.
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Item - 'History' tab

Property Definition

History

Displays the currently selected Administered Item's history of changes.

Date The date and time of the modification.

User profile The user who modified the item.

Operation The type of operation that triggered history storage.

Data model The data model that owns the Administered Item.

Universal name The Administered Item's universal name.

ISO type The Administered Item's ISO type.

Logical data type The Administered Item's logical data type.

12.2 Context

Context

Property Definition

Name A context is used to provide the naming and definition of any Administered Item. The context
name can use any naming convention except the use of "[ON]" as prefix. This prefix is reserved for
contexts that are created automatically during the synchronization process between a data model and
Administered Items.

Identifier Identifier used as tag link reference.

Description The description of the context is localized by language.

Language A context can be related to a language.

Country A context can be related to a country.

Criterion A context can be related to a classification criterion coming from the classification scheme that is
defined in the 'Classification' table group.

Parent context A hierarchy of context can be defined.
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12.3 Classification

Item relation

Property Definition

Administered Item
from

The Administered Item from which this relationship stems.

Administered Item to The Administered Item where this relationship terminates.

Relation The type of relationship these items share. Several default types are provided. You can select Create
from the drop-down list to add a custom defined relationship. Additionally, you can navigate to the
table that stores these values and add one there. The table location is Reference data → Relation type

Criterion

Property Definition

Identifier Identifier used as tag link reference.

Name A criterion is a classification item that is attached to a 'Classification domain' through the
'Classification' table.

Description The description is localized by languages.

Criterion hierarchy

Property Definition

Parent criterion The parent criterion in this relationship. The Criterion table stores these values.

Child criterion The child criterion in this relationship. The Criterion table stores these values.

Item classification

Property Definition

Administered Item The Administered Item you want to apply this classification to.

Criterion The criterion you want to use to define this classification.

Description A description of this classification.
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12.4 Party

Item party

Property Definition

Administered Item The Administered Item that is linked to a Party among those declared in the 'Party' table domain.

Party A party among ones declared in the 'Party' table domain.

Role A role that the party plays in relation to the Administered Item. This role is one among the list that is
defined in the 'Party' table domain.

Party type The type of the Party automatically displays depending on the selected Party.

Description Any additional description can be used.

Data repository party
A Data repository can be associated to one to many parties playing certain roles.

Property Definition

Data repository A Data repository on which a party is configured.

Party A Party involved in the Data repository.

Role The role the Party plays in relation the Data repository.

Party type The type of the Party automatically displays depending on the selected Party.

Data model party
A Data model can be associated to one to many parties playing certain roles.

Property Definition

Data model A Data model on which a party is configured.

Party A Party involved in the Data model.

Role The role the Party plays in relation the Data model.

Party type The type of the Party automatically displays depending on the selected Party.
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Party

Property Definition

Home tab

Identifier Identifier used as tag link reference.

Name A party can be any type of party such as: organization, application, systems, etc.

Second name Second name of the party

Image Specifies the image to associate with this party. This list allows you to select from images uploaded to
the 'Reference' → 'Image' table.

Display label on image If set to 'Yes': The party's label, specified by the 'Name' property, displays along with the image.

If set to 'No': The label does not display.

Phone Phone

Email Email

Country Country

Language Language

Party type Any type of party can be created in the Governance repository, such as Organization, Business division,
Region, Country, Application, System, Report, etc. You can attach any type of party to an Administered
Item with additional information about the party's role. For instance, an 'Application SAP' party with its
type as 'Application' can be 'Owner' of an 'Employee' Administered Item.

Registration authority identifier

International code
designator

When the Party identification must apply the ISO international coding convention.

Organization identifier When the Party identification must apply the ISO international coding convention.

Organization part
identifier

When the Party identification must apply the ISO international coding convention.

Organization part
identifier source

When the Party identification must apply the ISO international coding convention.

Description The description is localized by languages.

Administered Item tab: This tab displays a RACI style view of the party involvement by Administered Item.
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Property Definition

Administered Item The Administered Item linked to a party declared in the 'Party' table.

Role A role that the party plays in relation to the Administered Item. You can specify these roles in the
'Party' domain.

Party type The type displays automatically depending on its assigned type.

Description You can use any additional information to enrich understanding of the party.

Data model tab: This tab displays any roles the selected party plays with data models.

Data model The data model on which the party plays a role.

Role The role the party plays in relation to the data model.

Party type The party type automatically displays depending on the selected party.

Data repository tab: This tab displays any roles the selected party plays with data repositories.

Data repository The data repository on which the party plays a role.

Role The role the party plays in relation to the data repository.

Party type The party type automatically displays depending on the selected party.

Party hierarchy
This table allows you to create a parent/child relationship between parties.

Property Definition

Parent party The selected party becomes the parent in this relationship.

Child party The selected party becomes the child in this relationship.
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Type

Property Definition

Name Any type of party can be created in the Governance repository, such as Organization, Business division,
Region, Country, Application, System, Report, etc. You can attach any type of party to an Administered
Item with additional information about the party's role. For instance, an 'Application SAP' party with its
type as 'Application' can be 'Owner' of an 'Employee' Administered Item.

Is prebuilt A value of 'Yes' indicates that the add-on included this default 'Party type'. A value of 'No' indicates that
you created this 'Party type'. You cannot change images associated to default 'Party type(s)'. However,
if you've created your own 'Party type', you can associate it with a custom image.

Image Specifies the image to associate with this party type. This list allows you to select from images
uploaded to the 'Reference' → 'Image' table.

Display label on image If set to 'Yes': The party type's label, specified by the 'Name' property, displays along with the image.

If set to 'No': The label doesnot display.

Description The description is localized by languages

Role

Property Definition

Name Any type of role can be created in the Governance repository, such as Consumer, Owner, Populated by,
Transformed by, Used by, etc. F For instance, an 'Application SAP' party with its type as 'Application'
can be 'Owner' of an 'Employee' Administered Item.

Is prebuilt A value of 'Yes' indicates that the add-on included this default 'Party role'. A value of 'No' indicates that
you created this 'Party role'. You cannot change images associated to default 'Party role(s)'. However, if
you've created your own 'Party role', you can associate it with a custom image.

Image Specifies the image to associate with this party role. This list allows you to select from images
uploaded to the 'Reference' → 'Image' table.

Display label on image If set to 'Yes': The party role's label, specified by the 'Name' property, displays along with the image.

If set to 'No': The label doesnot display.

Description The description is localized by languages.

12.5 Rules
The 'Rules' domain allows you to create rules and link them to Administered items. In the current
version of the EBX® Information Governance Add-on repository, you have to manually create the
rules you want to attach to Administered items.
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Rule

Property Definition

Rule name You can use any naming convention.

External code An open field that allows you to define a code for the rule.

Rule description Free description.

Rule message The error message the rule can raise.

Type of rule A rule can be categorized into a type of rule.

Scope Description of the rule's scope.

Metric Description of the rule's metric.

Comments Additional information used to describe the rule.

Rule on Item

Property Definition

Item The Item on which the rule is applied.

Rule The rule applied on the Item.

12.6 Reference data

Logical data type

Property Definition

Name Name of the Logical data type.

Icon The icon used to represent this logical data type.

Display label on icon Determines whether the label displays on the icon.

Description Description. This information is provided by the add-on and cannot be modified.
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ISO type

Property Definition

Name Name of the ISO type.

Icon The icon used to represent this ISO type.

Display label on icon Determines whether the label displays on the icon.

Description Descriptive text for this ISO type.

Tag link

Property Definition

Tag link The code used to refer to a piece of information in the EBX® Information Governance Add-on
repository. For instance 'ai' allows you to refer to an Administered Item.

Any description text can integrate "tag links" to refer to any information contained in the governance
repository. For instance, the text 'Please refer to the item ai3392' is automatically translated into 'Please
refer to the item 3392' (the hyperlink is computed thanks to the key word 'ai'). A list of ready-to-use
key words is available to reach any information in the governance repository (refer to the 'Tag link'
table in the 'Reference data' group).

Reference table The table related to the tag link.

Description Description of the tag link.

Operation

Property Definition

Name The 'Operation' property is used to state how an Administered Item is created: either automatically by
the add-on or manually by a user.

Icon The icon used to represent this operation.

Display label on icon Determines whether the label displays on the icon.

Description The description is localized by languages.
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State

Property Definition

Name The 'State' property is used to indicate whether an Administered Item is aligned ("Aligned") or not ("No
Data Model reference") with its underlying data model.

Icon The icon used to represent this state.

Display label on icon Determines whether the label displays on the icon.

Description The description is localized by languages.

Registration status

Property Definition

Name Registration status is used to follow the life-cycle of an Administered item from its creation to its
deletion. Any type of registration status can be created. The add-on provides a Registration status set
that includes those defined in the ISO-IEC 11179 standard.

Icon The icon used to represent the registration status.

Display label on icon Determines whether the label displays on the icon.

Description Descriptive text for this ISO type.

Relation type

Property Definition

Name A relation is used to indicate what type of relationship it exists between two Administered Items. Any
type of relation can be created.

Description The description is localized by languages.



Documentation > Information Governance Add-on Documentation > User Guide > Governance repository data architecture

TIBCO EBX® Information Governance Add-on 91

Data repository type

Property Definition

Name Any type of data repository is possible.

Icon The icon used to represent this repository type.

Display label on icon Determines whether the label displays on the icon.

Description The description is localized by languages.

Data nature

Property Definition

Name Any type of data nature is possible.

Icon The icon used to represent this data nature.

Display label on icon Determines whether the label displays on the icon.

Description The description is localized by languages.

Country

Property Definition

Code Any country can be created.

Name Name of the country.

Language

Property Definition

Code Any language can be created.

Name Name of the language.
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Application

Property Definition

Code Any application can be created.

Name Name of the application.

Description Optional information.

Application role

Property Definition

Code Any application role can be created.

Name Name of the role.

Description Optional information.

Application status

Property Definition

Code Any application status can be created.

Name Name of the status.

Description Optional information.

Confidentiality

Property Definition

Code Any confidentiality can be created.

Name Name of the confidentiality.

Description Optional information.



Documentation > Information Governance Add-on Documentation > User Guide > Governance repository data architecture

TIBCO EBX® Information Governance Add-on 93

Maintenance rules

Property Definition

Code Any maintenance rule can be created.

Name Name of the maintenance rule

Description Optional information.

Rule type

Property Definition

Code Any rule type can be created.

Name Name of the rule type.

Description Optional information.

Extended attribute tables
This table allows you to define the list of tables and fields used as 'Extended data' to enrich the metadata
attributes. Extended data display as coupled data: Meaning (the table to select) and Value (a value
in the selected table).

Property Definition

Name Name used in the drop-down list 'Meaning'

Data space Data space where the table is located

Date set Data set where the table is located

Table Table used to feed the 'Meaning' drop list in the Extended attribute.

Field selection Field used to feed the 'Value' drop list in the Extended attribute.

Restricted to data
model

This table is only accessible to the Items created from the data model listed here. If this field is empty,
all Items can access this table.

Automatic display Setting this property to 'Yes' automatically displays this table when users open the related Item. Note
that when enabled you may receive a confirmation dialog from your browser after opening and closing
a related Item—even if no changes were made.
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Image
The 'Image' table allows you to upload images to the location specified in 'Administration' → 'TIBCO
EBX® Information Governance Add-on' → 'Images'. You can then assign an image to Party, Party
type, or Party role records that display in the Business Glossary.
To upload an image:

• From the 'Actions' menu, select 'Information Governance' → 'Upload image'.

• Enter a name for the image and specify the path to the image. Alternatively, you can use the
'Browse' option to point to the image.

• After clicking Upload Image, a preview of the image displays and you can still alter the name
before saving and closing.

Icon for quality bar
This table allows you to set which icons represent Item quality information when displayed in the
Business Glossary. You can set icon display for 'Approval', 'Deployment', and 'Quality'.

Property Definition

Code The identifier for this icon configuration.

Quality item The quality information this configuration pertains to.

Display digit on icon Determines whether the overall value displays along with the icon.

Display label on icon Determines whether the label displays with the icon.

Label Specifies the label.

Threshold value Set the threshold value.

Icon below threshold Determines the icon used if the value is below the specified threshold.

Icon equal 100 Determines the icon used if the value is 100.

Icon equal 0 Determines the icon used if the value is 0.

Icon equal threshold Determines the icon used if the value is equal to the specified threshold.

Icon above threshold Determines the icon used if the value if above the specified threshold.

Java class compute
value

The Java class used to compute the quality value.
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Icon for hierarchy view
This table allows you to assign icons to represent different types of Administered Items when viewing
the 'Item' table as a hierarchy. Simply create a new record and link the 'Type' with a provided icon.

Property Definition

Type Indicates the type of node displayed in the hierarchy.

Icon Specifies which image displays for the selected type.

12.7 History
You can save a history of actions that modify Administered Items. You must enable this feature
by setting the 'Enable history' property in the Information Governance → User preferences to 'Yes'.
Although, item modification saves a history record, a record is not saved when an item is created, you
comment on an item, or physically delete an item. To view all item history, use the 'History' table. If
you only want to view a specific item's history, open the item and select its 'History' tab.

History table
Each record in the 'History' table corresponds to an action taken that modified an Administered Item.
The number of records stored in this table depend on how you set the user preferences. See the
'Configuring user preferences' section for more information. When viewing the 'History' table, you
can select 'Information Governance' → 'Purge Administered Item history' to clear the records.
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Each record in this table contains the following information about item changes:

Property Definition

Date The date and time of the modification.

User profile The user who modified the item.

Operation The type of operation that triggered history storage.

Data model The data model that owns the Administered Item.

Universal name The Administered Item's universal name.

ISO type The Administered Item's ISO type.

Logical data type The Administered Item's logical data type.

Operation table
This table stores operations that can apply to events that trigger an entry in the history log.
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CHAPTER 13
Querying Administered Items and

comments
The add-on provides the 'Query metadata' and 'Query comments' services that allow you to query
Administered Items and comments, respectively. Additionally, the 'Purge comments' service facilitates
quick lookup and removal of comments. You can locate these services via any EBX® Information
Governance Add-on based data set's 'Actions' menu.
The following steps demonstrate an Administered Item query, however the query and purge services
behave similarly and you can perform similar steps to achieve the desired result. Just note that with
the 'Purge comments' service, even though they don't display, all comments that match the criteria are
deleted when you click 'Execute'.
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• Run the 'Query metadata' service to open the query form.
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• As shown in the image below, you can specify criteria for the search.
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• After entering the desired information, click 'Query' to display the 'Result' tab (shown below).
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CHAPTER 14
Exporting the governance repository

Note that if you are using version 1.6.0, or newer, this service is not available. The 'Export in Relational
data' service located in the 'Data model' table allows you to export metadata as a relational tables.
Then, you can export the relational tables in XML format or as an Excel spreadsheet with the add-
on for Excel. This allows you to use a third party tool to query and handle information contained
in the table. The relational table containing the metadata is located in the 'Information Governance
- export' data space.
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'Data model documentation' is a normalized data model used to handle the data from data hierarchy
views as illustrated below. Since this is also a relational data storage mode, you can query using SQL
third party tools.
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From the 'Field' table, the 'View by tables and fields' data hierarchy view allows you to get a list of
the Administered Items by tables and fields.

Special notation:

In relational mode, the size of a string is limited (2,000 characters in Oracle). Any definitions over this size are
truncated.
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CHAPTER 15
Using the governance repository to
dynamically update EBX® tips and

labels
This chapter contains the following topics:

1. Updating tips and labels overview

2. Declaring the add-on's API in a data model

3. Configuring info-tips and labels

4. Examples

5. Display rules for tips and labels

15.1 Updating tips and labels overview
Definitions applied to tables and fields can be reused to dynamically configure tool-tips and labels.
Rather than using values specified in the data model, definitions can be enriched from the EBX®
Information Governance Add-on repository.
You can associate a user profile with a context so that those users will see information specific to their
needs. For instance, a table in the data model with a default label of 'Empl', will automatically display
as 'Employee' or 'Staff' depending on the context with which a user's profile is associated.
As highlighted in the next section, the add-on's API needs to be declared in order to use the governance
repository to dynamically update tips and labels.

15.2 Declaring the add-on's API in a data model
Once a data model has been extended with the following declaration, tool-tips and labels applied to
the tables and fields are retrieved from the governance repository. To configure how this information
displays, see the next section 'Configuring tooltips and labels'.
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Step 1: Add the default API class
"com.orchestranetworks.addon.igov.IGovLabelingSchemaDocumentation" to the data model's
Component library.

Step 2: Navigate to the 'Data model properties' and in the 'Documentation' field select the API class
you just added.
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15.3 Configuring info-tips and labels
If you have administrative access, you can configure the add-on's info-tips and labels by opening the
'Administrative' tab > 'Metadata Management' > 'TIBCO EBX® Information Governance Add-on >
'Infotip and labels'.
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The table below describes the properties that you can configure. Please refer to the Java doc for a
technical description of the API.

Property Definition

User profile The user profile to which this add-on API configuration applies.

IGov repository The data space for the add-on repository to use.

Data model The data model to which the API configuration applies.

Info-tip is active If 'True': The add-on repository provides the info-tip.

If 'False': The data model provides the information for the info-tip.

Table label is active If 'True': The add-on repository provides the table label.

If 'False': The data model provides the information for the table label.

Field label is active If 'True': The add-on repository provides the field label.

If 'False': The data model provides the field label.

Main context The main context that determines the definition provided by the add-on repository.

Alternative context The alternative context that determines the definition provided by the add-on repository when the main
context can not be fulfilled.

DMA context by
default

If the main context and alternative context are not implemented, then the DMA context can be used to
define the tool-tip:

• If 'True': The DMA context is used by default.

• If 'False': The DMA context is not used by default.

Add D.E.C. in the field
definition

If 'True': The field's info-tip displays the definition of its associated Data Element Concept (D.E.C.).

If 'False': The field's info-tip is not enriched with the definition of its associated D.E.C.

For instance, the 'age' field is a Property in the add-on repository with its own definition. But, the 'age'
field in the 'Employee' table is also a D.E.C. with own definition.

Use D.E.C. as field
label

If 'True': The field's label comes from the related Data Element Concept (D.E.C) in the add-on
repository.

If 'False': The field's label comes from the related Property in the add-on repository.

For instance, the 'age' field is defined as the 'Age' property in the add-on repository and also included in
the 'Employee' table as a D.E.C. Depending on whether the 'Use D.E.C as field label' is True or False,
the label will come from either the property or the associated D.E.C.

Hide Universal name Determines whether the 'Universal name' displays when users view the tool tip.

Rule activation group

Display rule
information

Determines whether rule information, such as rule name and description, display in the tool tip. Note
that linked rules are declared in an Item's 'Rule' tab.
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Property Definition

Maximum number of
rules

Specifies the number of rules displayed on the tool tip.

15.4 Examples
The next sections illustrate the following uses cases:

• Info-tip not activated.

• Info-tip activated.

• Label on table activated.

• Dynamically naming tables using contexts.

• Dynamic naming fields using contexts.

• Customizing EBX® Information Governance Add-on naming

Info-tip not activated
As illustrated, the 'Info-tip is active' property is set to 'No'. The 'Table 1' name and definition display the
values from the data model for 'Table 1'. Any additional information from the governance repository
does not display.
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Info-tip activated
As illustrated below when the 'Info-tip is active' property is set to 'Yes', a tool-tip displays the 'Universal
name' and information from the governance repository.
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Label on table activated
When the 'Table label is active' property is set to 'Yes', the table name that displays is automatically
provided by the governance repository. In the illustration below the 'US Marketing' context is used
and the table label displays as 'Staff' instead of 'Table 1'.
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Dynamically naming tables by using contexts
All tool-tip and label definitions in the governance repository are associated with contexts. As shown
below, you can assign a main and alternative context to a user profile.
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After assigning contexts to a user profile, information relevant to their work environment can
dynamically display. The following image illustrates how information displays depending on the
context associated with the user profile.

Dynamically naming fields by using contexts
Just as with table names and tool-tips, the information displayed in table fields can be dynamically
updated based on a user profile's associated context. Data can be better understood by users when it
is presented in a way familiar to them.
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The illustration below shows how the field labels are customized depending on whether a
'Manufacturing' or 'Sales' context is used.

Customizing EBX® Information Governance Add-on naming
You can change the add-on naming in the same way as with your own data models. These add-on
applies these changes by context and user profile which allows you to tailor what specific users, or
groups of users see. The image below shows an example of changing the 'Item' table to 'Governed
Elements'.

To configure info-tips and labels for the Information Governance data model:

• Create a new record in the 'Data model' table.

• Specify the ebx-addon-igov.xsd in the 'Data model' property.
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• Use the next two drop-down lists to select the desired data space and data set.

• After updating any other desired properties, save and close.

• In the 'Data model' table, select the check box corresponding to the data model you just created
and from the 'Actions' menu select 'Information Governance' > 'Create Administered Items'.
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• In the 'Item' table navigate to and select the table, or field you want to update. In this example
we are updating the 'Item' table itself.
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• Open the table's 'Definition' tab and create a new context and definition. The add-on displays
the text you specify in the 'Definition' field when a user and data model are associated with the
context. In this example, we entered 'Governed Elements'.

• Create a new 'Infotip and labels' configuration that associates the user, context and data model.

15.5 Display rules for tips and labels
The display of info-tips and labels conforms to the following guidelines for users and roles. If a
configuration is specified for a user, this configuration is used even if there are other configurations
for the role(s) that this user belongs to. If no configuration exists for a user, the add-on uses the first
role returned that this user is configured for. For example, if sorted by creation date (oldest to newest),
the first record for this role will be an older record.
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Rules applied to info-tip

EBX® element ISO concept Display Rules

Table Object class Universal name

Definition of the Object class for the configured context

Default definition of the table from the Data model

Field Property Universal name

Definition for the Property for the configured context

Default definition of the field from the Data model

If 'Add D.E.C. in the field definition' = 'Yes' then:

• Universal name of the D.E.C.

• Definition of the D.E.C for the configured context

Group of field Object class Universal name

Definition of the Object class for the configured context

Default definition of the table from the Data model

Rules applied to label

EBX® element ISO concept Display Rules

Table Object class Short definition of the Object class for the configured context

Field Property If 'Use D.E.C. as field label' = 'Yes'

• Short definition of the D.E.C. for the configured context

If 'Use D.E.C. as field label' = 'No'

• Short definition of the Property for the configured context

Group of field Object class Short definition of the Object class for the configured context
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CHAPTER 16
Configuring user preferences

Under the EBX® Administration tab, the 'TIBCO EBX® Information Governance Add-on' data space
contains the 'User preference' table that allows you to adapt metadata views.

Property Definition

IGov repository The add-on repository on which the user preference configuration applies.

Item label display This property determines how an Administered item's name displays in the data hierarchy views and
other parts of the add-on repository UI. You can specify an item's 'Logical label', 'Logical name' or
'Universal name'. By default, the 'Logical label' is used. In case the 'Logical label is not available, then
the 'Universal name' is used.

'Hidden item' active If set to 'Yes': Every Administered Item with its 'Is hidden' property set to 'Yes' is hidden except from a
user with administrative privileges.

If set to'No': Every Administered Item with its 'Is hidden' property set to 'Yes' are no longer hidden.

'View by only' active If set to 'Yes': The Administered Item is displayed only for user profiles that are defined for this
Administered Item. When the Administered Item is created, by default the 'All profiles' is configured.

If set to 'No': The Administered Item is displays no matter what user profile is active.

'Also defined in'
active

If set to 'Yes': The 'Also defined in' tab is displayed to get all Administered Items that are related to the
Administered Item currently displayed.

If set to 'No': the 'Also defined in' tab is not displayed.

'Quality indicator'
active

If set to 'Yes': The 'Quality' tab is displayed when quality indicators are configured for the Administered
Item currently displayed. This configuration is done by the 'Dashboard' table.

If set to 'No': The 'Quality' tab is not displayed.

'Graph active' If set to 'Yes': The 'Graph' tab displays for tables registered with the EBX™ Graph View Add-on.

If set to 'No': The 'Graph' tab does not display.

'Meta graph' active If set to 'Yes': The 'Meta graph' tab displays when the EBX™ Graph View Add-on is configured for the
current Administered Item's underlying data model.

If set to 'No': The 'Meta graph' tab does not display.

RACI configuration group
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Property Definition

Party image priority Choose whether to display the 'Party', or 'Party type' image.

Party image width Specifies the image width.

Party image height Specifies the image height.

Party role image
width

Specifies the Party role image width.

Party role image
height

Specifies the Party role image height.

History group

Enable history You can activate a recorded history for Administered Items. When active, the system creates a new
record in the add-on repository's 'History' table. You can also select an item and open its 'History' tab to
view changes to the item.

If set to 'Yes': Item history activates.

If set to 'No': Item history is not active.

Use stack When you activate the 'Use stack' property, the system saves item history using a first in, first out
(stack) approach. The 'Stack size' property limits the number of records kept in the stack. If you don't
activate the 'Use stack' property, the system stores all records and this can lead to degradation of your
environment.

If set to 'Yes': The stack approach is active.

If set to 'No': The stack approach is not active.

Stack size Determines the number of records the system saves before deleting the oldest. Each time item
modification occurs the system saves a new history record.
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CHAPTER 17
Configuring dashboard

Under the EBX® Administration tab, the 'TIBCO EBX® Information Governance Add-on' data space
contains the 'Dashboard' table that allows you to configure the use of the quality indicators.

Property Definition

IGov repository The add-on repository on which the user preference configuration applies.

User profile The Dashboard configuration is applied to this user profile

Administered Item The Administered Item on which the Dashboard configuration is applied.

Dashboard The dashboard used to retrieve the quality indicators of the Administered Item. The dashboards are
configured with the EBX® Insight Add-on.
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CHAPTER 18
Configuring trigger on Administered

item
Under the EBX® Administration tab, the 'TIBCO EBX® Information Governance Add-on' data space
contains the 'Trigger on Administered item' table that allows you to declare a treatment to execute
when the creation and modification of a metadata occurs.

Property Definition

IGov repository The add-on repository on which the user preference configuration applies.

Java class The Java class which will be triggered while modifying or creating an Administered item. This class
must extend the interface IGovAdministeredItemListener and must be public to be accessible by IGov.

Is active 'True': This class will be triggered.

'False': This class will not be triggered.
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CHAPTER 19
Using the Graph view

This chapter contains the following topics:

1. Graph view applied to the repository

2. Attaining your preferred node arrangement

19.1 Graph view applied to the repository
You can apply the EBX® Graph View Add-on to the EBX® Information Governance Add-on
repository and exported data as highlighted below.
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When viewing an Administered item, the 'Meta graph' tab shows a graph view of the selected item in
relation to its metadata contained in the current governance repository. From this view, you can query
the metadata and use services to perform other actions by clicking on the nodes.
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When the selected Administered item is a type of 'Object Class', the additional 'Graph' tab is available.
It allows you to see the graphical view of the data model under the governance process. The EBX®
Graph View Add-on must have previously been enabled for this table in order to the 'Graph' tab.

19.2 Attaining your preferred node arrangement
You can make your own node arrangement and save node positions using the 'Save layout' service. You
also can reuse an existing arrangement for a data model by duplicating the records in the 'User graph
data' table located under the Administration tab 'TIBCO EBX® Graph View Add-on' configuration
domain (please refer to the EBX Graph View Add-on documentation for additional information).
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CHAPTER 20
Business glossary

This chapter contains the following topics:

1. Overview

2. Configuration

3. Glossary preference table

4. Glossary preference template table

5. Tab label

6. Repository labeling

20.1 Overview
The TIBCO EBX® Business glossary communicates informational assets such as business concepts
and their related terminology along with associated definitions and relationships. This is accomplished
using an interface that provides access to data much in the same way as a traditional web-based front-
end application. Because of the familiarity of this type of interface, you can quickly learn the ins and
outs of the EBX® Business glossary and harness its ability to show detailed information about your
data.
Authorized users can browse the glossary or search for information/metadata contained in an add-on
repository. Different tabs show complete sets of information regarding the selected Administered item.

Special Notation:

Please refer to the 'Business glossary' User Guide for a full description of the web application.

To make the business glossary available to users, you have to configure the authorized users and
the user preferences as described in the rest of this chapter. A 'Business Glossary' service in the
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'Information Governance' data space (or any children) allows you to execute the business glossary
inside EBX® UI:

To execute the Business glossary outside the EBX® UI, you have to use the 'web component' process
as documented in the EBX® Reference Manual under the 'Using EBX® as a web component' topic.
The next section highlights the process to configure the business glossary. The tables to configure
are located in the Administration tab of EBX®, data space 'TIBCO EBX® Information Governance
Add-on'.

20.2 Configuration
Administrators can access Business glossary configuration settings from the 'Administration' tab →
'Metadata management' group → 'TIBCO EBX® Information Governance Add-on' data space. The
'Business glossary' domain contains the following tables that determine glossary configuration:

• Glossary preference

• Glossary preference template

• Tab label

• Repository label

20.3 Glossary preference table
Each record in the Glossary preference table corresponds to a set of defined preferences for the
Business glossary. Numerous properties afford you fine-grained control over what selected user
profiles can see in the Business glossary. You can set each option manually, or specify a 'Glossary
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preference template'. When you specify a template, property values inherit those defined in the
template. Even if you use a template, you can override individual properties to specify a custom value.
When viewing the 'Glossary preference' table, you can double-click to edit an existing set of
preferences, or click the '+' icon to create a new set. The following sections describe the options you
can edit.
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General properties in the 'Home' tab
The following table describes the general properties in the 'Home' tab that allow you to turn the
Business glossary on/off and specify which templates to use:

Property Definition

User profile The user profile(s) that this glossary preference record applies to. This drop-down list pre-populates
with available profiles.

IGov repository The add-on repository that this glossary preference configuration applies to. This drop-down list
populates with existing repositories.

Is active With Yes selected here, the glossary preference configuration is active. Selecting No deactivates the
configuration.

Is default With Yes selected here, this glossary preference configuration automatically displays when users enter
the Business glossary.

Glossary preference
template

The Glossary preference template used for this configuration. After selecting a template, you
click Save to populate the remaining configuration properties with the values defined in the selected
template.

Header title The text you enter in this field and the description box below displays as the Business glossary header
and description, respectively.

Header image The Header image group allows you to choose an image to display as the Business glossary icon and
specify its default size

• URL - The specified location of the image used in the Business glossary header.

• Width - The header image set width.

• Height - The header image set height.

Administrator
contact email

An email address to contact the Business glossary's administrator.

Link to Reference
data

With 'Yes' selected, a link from the metadata to the actual data is available. For example, from the
'Client' Object class, a link allows the user to display the content of the 'Client' table. The display takes
into consideration EBX® user permissions.

Is search active This property determines whether or not users assigned to this configuration can use the Search tab.

Show header by
default

Determines whether the Business Glossary header automatically displays when users open the glossary.

Default tab This property determines the default active tab in the Business glossary's Query panel. You can choose
from 'Search', 'Browse',or 'List view'.

Results per page The number of results shown per page.

Default context This drop-down list allows you to select the context that loads by default when the Business glossary is
opened.
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Property Definition

Allowed context Each context listed here will show up in the Context drop-down list. To add a context click the plus
icon.

Default data view This is the default view when browsing the Administered items.

Allowed data model When you add a data model to this list, users can access it in the Business Glossary. By leaving the
property undefined you place no restrictions on data model access. Please note that if an allowed data
model contains no Items, users will not see it in the 'Browse' tab even if it is allowed.

Allowed data view Occurrences added to this list will also be shown and selectable when users enter the Business glossary.

Table 1: General configuration properties

The Tab display tab
The 'Tab display' tab allows you to specify which tabs display when users enter the Business glossary.
Additionally, you can use the 'Label' property to customize each tab's label display.
To set tab display, either allow it to inherit from, or overwrite the template values. The square icon
after each tab name toggles inheritance on and off. If changing values:

• Set the corresponding tab's 'Is displayed' property to 'Yes', or 'No'.

• You can optionally change the tab's label, or create a new one using the 'Label' drop-down list.
If left undefined, each tab uses the standard label.
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• After saving and closing, all affected tabs and labels update.

Main & More tab
This tab allows you to limit the information that displays when the user profiles associated with this
configuration view the Business glossary 'Main', 'More', or 'Physical' tabs. By default each group
inherits settings from the 'Glossary preference template' specified on the 'Home' tab. Before altering
any values, you need to override this inheritance by clicking the small box after the group name. For
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example, the configuration shown in the following image determines that the 'Data repository' field
only displays in the 'Physical' tab when the field contains a value.

Property tab
This tab allows you to choose which columns display when the user profiles associated with this
configuration view the Business glossary's 'Property' tab. Each field displayed here represents a
column in the 'Property' tab's table. By default each group inherits settings from the 'Glossary
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preference template' specified on the 'Home' tab. Before altering any values, you need to override this
inheritance by clicking the small box after the field name.

Relation tab
Groups on this tab represent tables that can display in the Business glossary's 'Relation' tab. The
fields in each group correspond to the table columns. Selecting Yes or No determines whether the
associated column displays for user profiles associated with this configuration. By default each group
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inherits settings from the 'Glossary preference template' specified on the 'Home' tab. Before altering
any values, you need to override this inheritance by clicking the small box after the group name.

Physical tab
Each group on this tab represents types of data assets associated with Administered Items. Their 'Tab
display' properties indicate on which Business glossary tab this group displays. After each field name,
a status indicates whether the field displays, or if it only can be seen when defined. By default each
group inherits settings from the 'Glossary preference template' specified on the 'Home' tab. Before
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altering any values, you need to override this inheritance by clicking the small box after the group
name.

Party tab
This tab displays the possible columns that display on the Business glossary's 'Party' tab. You can
choose which columns display for user profiles associated with this configuration. By default each
group inherits settings from the 'Glossary preference template' specified on the 'Home' tab. Before
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altering any values, you need to override this inheritance by clicking the small box after the column
name.

Classification tab
This tab allows you to choose which type of view displays when user profiles associated with this
configuration view the Business glossary's 'Classification' tab. By default these settings are inherited
from the 'Glossary preference template' specified on the 'Home' tab. Before altering any values, you
need to override this inheritance by clicking the small box after the column name.

Rule tab
Each field on this tab corresponds to a column that displays when user profiles associated with this
configuration view the Business glossary's Rule tab. You can choose which columns display for these
users by specifying Yes or No. By default these settings are inherited from the 'Glossary preference
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template' specified on the 'Home' tab. Before altering any values, you need to override this inheritance
by clicking the small box after the column name.

Quality tab
This tab allows you to determine which percentages of completion display when user profiles
associated with this configuration view the Business glossary's 'Quality' tab. By default these settings
are inherited from the 'Glossary preference template' specified on the 'Home' tab. Before altering any
values, you need to override this inheritance by clicking the small box after the field name.

List view configuration tab
This tab allows you to enable or disable 'List view' tab display, specify the number of items shown
per page and specify the columns shown. These settings apply to the user profiles associated with this
configuration. By default these settings inherit from the 'Glossary preference template' specified on
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the 'Home' tab. Before altering any values, you need to override this inheritance by clicking the small
box after the field name.

Search configuration tab
The 'Search configuration' tab allows you to adapt Business glossary fuzzy search results. By default
these settings inherit from the 'Glossary preference template' specified on the 'Home' tab. Before
altering any values, you need to override this inheritance by clicking the small box after the field name.
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Icon bar tab
This tab allows you to enable display of informational icons in the Business Glossary's Icon bar. When
users select an Administered Item (Object Class or Property) the icons that display provide a quick-
reference to the Item's corresponding field value. For example, if an Item's 'Registration' field value is
'Unregistered', users can see the icon representing this value without having to navigate to another tab.
To configure icon display:

• Override field inheritance for the desired Administered Item type. By overriding the 'Object Class'
field inheritance the icon categories you enable will display each time a user selects an Item
considered an Object Class. This also applies to the 'Property' field.

• Click '+' and select an icon category from the drop-down list. You can repeat this process to add
multiple categories. The icons display in the Glossary in the order shown here. You can use the
arrows to re-order, or the trash can to remove categories.

• Save and close when finished.
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The image below shows the result of the above configuration with an Object Class selected.
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Data model tab
This tab allows you to determine whether a data model's definition displays when a user selects it in
the Business Glossary. When you enable the display, you can also configure what information displays
by toggling the corresponding properties on and off.

20.4 Glossary preference template table
The Glossary preference template table allows you to pre-define templates for use in defining a
Glossary preference. Two pre-defined templates are provided: [ON] Full view and [ON] Simple
view. These templates cannot be deleted. The [ON] Full view template enables users assigned to this
template to see all tabs and fields. The [ON] Simple view template:

• Shows only the Main, More and Property tabs

• Hides the item's history

• Hides the Is field, Is table, Is D.E.C. and Is data type

• Disables the Search tab

See the above 'Glossary preference table' section for descriptions of template properties.
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20.5 Tab label
Each record in this table corresponds to a label you can use for Business Glossary tabs. Any labels
with a prefix of [ON] are unmodifiable. However, you can create and delete your own labels using
the + icon and Actions menu, respectively.

20.6 Repository labeling
The Repository label table allows you to create labels for add-on repositories. The Business glossary
uses these labels as identifiers (in the Identification tool bar) when the glossary executes outside the
EBX® UI. If you don't define a label, the system uses the default data set label.
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CHAPTER 21
Email management

This chapter contains the following topics:

1. Configuring Email management

2. Email template table

3. Email template variable table

21.1 Configuring Email management
The settings in the Email management domain allow you to setup predefined email templates. When
an email recipient clicks a link to an Administered Item, the Business glossary opens with the item
in focus.
The following tables that contain email configuration settings can be found on the Administration
tab → TIBCO EBX® Information Governance Add-on → Email management:

• Email template

• Email template variable
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21.2 Email template table
The Email template table allows you to define the content included in emails and allows you to
specify whether or not the template is active. You can use one of the pre-defined [ON] templates, or
create one of your own. The following properties can be set:

Property Definition

Code The code of the template

Name The name for this template.

Is active If set to Yes, this template is active.

If set to No, this template is not active.

Note: Only one template can be active for each email type.

Content The initial field specifies the title of emails sent using this template. The text box allows you to enter
variables that will populate the email body. To see the pre-defined list of variables, open the Email
template variable table.

Table 2: Email template properties

21.3 Email template variable table
The Email template variable table stores all variables available for an email template. Currently,
all variables are pre-defined and these records are not user-editable. Each record shows the variable's
name, type and description of the information that variable will insert into an email. Current limitations
De-duplication policy of the Administered Items:

• Application of several matching policies including fuzzy match.

• Application of these policies for any type of data asset: table, field, complex data type, etc.

• Application of these policies for the fields 'universal name' and the 'description'.

Party management

• Configuration of roles that are permitted based on type of party.

• Use of EBX® directory as a default list of Party.

Administered Item creation

• Manual creation of Administered Items, with attachment to a data model or not.

• Extension 'custom property' into an Administered Item.

Tag link

• A tag link cannot be enriched with HTML tags. For instance if coding color or style are used
(bold, italic, etc.) then the tag link is no longer interpreted by the add-on.

• Tag link are not active in the Info-tip display.
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Business Glossary
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CHAPTER 22
Business Glossary overview

The Business Glossary communicates informational assets such as business concepts and their related
terminology along with associated definitions and relationships. The Business Glossary interface
provides access to data much in the same way as that of a traditional web-based front-end application.
Because of the familiarity of this type of interface, you can quickly learn the ins and outs of the
Business Glossary and harness its ability to show detailed information about your data.
Authorized users can browse the glossary or search for information/metadata contained in an TIBCO
EBX® Information Governance Add-on repository. Different tabs show complete sets of information
regarding the selected Administered Item. Some features include:

• Definitions sortable by context and language

• Ability to share information via email and comments

• Viewing Administered Item history

• Display of party, party type and party role attributes in a RACI style matrix with optional use
of images.

How the Business Glossary displays and how you access it depends on your system's configuration.
It is accessible:

• either, through the 'Business Glossary' service available from the 'Information Governance' data
space. When accessed via this route, the glossary displays in the TIBCO EBX® UI.

• or, via an EBX® 'Web component' that displays the repository in a purely web-based application
style, without any additional EBX® UI elements.
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Business Glossary configuration settings are described in the EBX® Information Governance Add-
on User Guide.

Illustration 1: Accessing the Business Glossary

Special notation key:

Important recommendation for the use of the feature.

This feature is not yet available in the current release.
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CHAPTER 23
Main display area

This chapter contains the following topics:

1. Main view

2. Business Glossary header

3. Icon bar

4. Business Glossary Query Panel

5. Business Glossary information panel
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23.1 Main view
The Business Glossary UI incorporates the following four areas: a Header Area, an Icon Bar, a
Query Panel (left-hand-side), and an Information Panel (right-hand-side). The following image
highlights these areas:

23.2 Business Glossary header
The Business Glossary Header Area displays a glossary definition that administrators can customize
and include information about the glossary's current focus. See the EBX® Information Governance
Add-on User Guide for more information on Business Glossary configuration. At the header's top-
right, the following menus and options allow you to:

• Select from available contexts

• Choose the current language

• If set to display for your profile, the Action menu contains options pertaining to the current
Administered Item including sending an email and exporting to Excel. This list and all
permissions involved are managed by administrators

• The Hide/Show header button toggles the Header Area display on and off
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The combination created by your selections in the Context and Language lists determines which
data displays in the different Business Glossary tabs. For example, if the values of Context and
Language were set to Executive definition and English, respectively, the Business Glossary would
show specific metadata related to the Executive definition context in the English language.

When you select an item in the Query Panel, its associated icon, name and containing data model
name display on the left side of the header-just above the Query Panel. This helps you identify which
Administered Item is currently in focus.

23.3 Icon bar
The Icon bar serves as a quick-reference for information regarding the selected Administered Item. At
a glance you may find the information you need without having to navigate through tabs and locate
the desired property.
For example, the Item selected in the following image shows its:

• ISO type is Object Class

• Logical data type is Table
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• Registration status is Candidate

23.4 Business Glossary Query Panel
The Query Panel contains the Browse, Search and List view tabs. Each tab employs a different
method to assist you in locating specific data contained in the current EBX® Information Governance
Add-on repository.

Search tab
The Search tab contains a standard search field and Search button. Clicking this button executes a
query that runs against the Administered Items contained in the currently selected context. Clicking
on an item returned in a search brings the Business Glossary's focus to that item. Note that this
does not search for specific Administered Items, but searches the values contained in the following
Administered Item fields:

• Universal name

• Logical name

• Logical label

• Long definition

• Short definition

• Long synonym

• Short synonym
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As shown in the following image, you can choose several options to specify which types of
Administered Items the search queries.

A ready-to-use search configuration automatically loads during installation of the EBX® Information
Governance Add-on. This configuration applies to all child data spaces created from the EBX®
Information Governance Add-on parent data space. Administrators can adapt this search
configuration to meet any special requirements. You can find search configuration settings in the
Administration tab → Technical configuration → TIBCO EBX™ Information Search Add-on
→ Configuration domain.

List view tab
The List view tab displays each data model available in the current context. When you select a data
model, its Object Classes and any associated definitions display in the information panel. You can
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view the properties contained in each Object Class by selecting the View Property checkbox. The
Operation column contains an action menu with quick access to view the item, or send an email
containing the item. When you select View data a pop-up displays with more in-depth information
and additional options at the bottom of the dialog. The following list describes these options:

• Go to item changes the Business Glossary's focus to this item.

• Open in a new window opens the Business Glossary in a new browser window with this item
in focus.

• Send email creates a new email containing this item. Administrators, see the EBX® Information
Governance Add-on User Guide for information on formatting email templates.

Browse tab
The Browse tab allows you to navigate through a standard hierarchy style view that shows the current
context's Administered Items. The View drop-down list allows you to set criteria that filter the types
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of Administered Items displayed in the Browse tab. Selecting an Administered Item focuses the
Information Panel and its tabs on that item.

23.5 Business Glossary information panel
The Information Panel resides on the bottom-right side of the screen. This is where you get to see
all of the Administered Item specifics. Each tab at the top of the panel contains a categorized set of
information about the currently selected Administered Item. Using glossary configuration options,
administrators can change the tab label and choose on which tab specific fields display. For detailed
options, see the Business Glossary configuration section in the EBX® Information Governance Add-
on User Guide.
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As shown below, a valuable aspect of the Business Glossary is that you can mouse-over any field
name and open context sensitive documentation about the field by clicking on the help icon.

The remainder of this section provides a brief overview of the default tabs and their respective fields.

• Main tab

• More tab

• Property tab

• Relation tab

• Party tab

• Classification tab

• Rule tab

• Quality tab

• Comment tab

Main tab
The Main tab displays the definition-as defined by the currently selected Context and Language-for
this Administered Item along with information regarding its location, data type, creation/modification
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date and current state. Note that the data model definition only displays if enabled. Also, an
administrator can determine which aspects of the definition display.
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More tab
The More tab provides a fine-grained view of the selected Administered Item. The Related definition,
Synonym, Universal synonym, Data nature and Description fields all display data related to the
currently selected Context and Language.

Property tab
The Property tab only displays if the selected Administered Item is an Object Class. This tab displays
a table that contains information about each of the Object Class properties. The column labeled
Operation contains an Action drop-down list. From this list you can:

• Select Send email to automatically open your email client and create a new message. The email
contains a link that opens the item in Business Glossary and other contents determined by email
management configuration settings.

• Click the the View data button to open a pop-up window that displays the property's definition
and related data. The buttons at the bottom of the window allow you to change the Business



Documentation > Information Governance Add-on Documentation > Business Glossary > Main display area

TIBCO EBX® Information Governance Add-on 165

Glossary's focus to this property, open the Business Glossary with this property in focus in a new
browser window, and send an email containing a link to this item.

Relation tab
The Relation tab shows the different types of relationships held by the currently selected item. The
following three categories of relationships can display depending on the selected item:

• Information displayed under the heading Relation by foreign key is specific to relationships
in the current data model. For example, a foreign key relationship between two tables. You can
click the Preview button which opens a pop-up window with more information about the selected
item. From this window you can switch Business Glossary focus to this item, send the item in a
preconfigured email format, or open another instance of the Business Glossary with the current
item in focus.

• The Relation between items heading displays any user defined relationships in the Item relation
table involving this item.

• Information shown in the table under the Also defined in heading pertains to other types of
relationships this item may hold. For example, a relationship could be that as defined by a Data
Element Concept (D.E.C.). You can use the Action menu's View data button to display a pop-up
window that contains more information. Additionally, you can switch Business Glossary focus
to this Administered Item, open a new browser window, and send an email using the options at
the bottom of the pop-up window.
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Physical tab
The Physical tab displays different fields that are specific to either a table, or field.
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Party tab
The Party tab shows any parties that are assigned to the currently selected Administered Item. You
can specify an image for each 'Party', 'Party type' and 'Party role' record. See the User Guide for
configuration information.

Classification tab
The Classification tab shows any classifications for the currently selected item.

Rule tab
The Rule tab shows any rules linked to the currently selected item. The rules that display are those
you created in the EBX® Information Governance Add-on.
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Quality tab
The Quality tab shows quality indicators configured on the currently selected item. Additionally, if
the TIBCO EBX™ Insight Add-on is configured for the selected item you can display the available
indicators.

Comment tab
The Comment tab allows you to post and share comments on the selected item.
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CHAPTER 24
Configuration

The Business Glossary view displays information depending on the configuration applied to the
EBX® Information Governance Add-on repository. Please refer to the user guide 'EBX® Information
Governance Add-on' section 'Business Glossary' for further information.
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Release Notes
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CHAPTER 25
Version 1.9.7

Released: March 2022
This chapter contains the following topics:

1. New features

2. Changes in Functionality

3. Changes to third-party libraries

4. Closed issues

5. Known issues

25.1 New features
This release contains no new features.

25.2 Changes in Functionality
This release contains no functionality changes.

25.3 Changes to third-party libraries
The following third-party libraries were updated:

• The Apache FontBox library was updated to version 2.0.25.

• The JQuery library was updated to version 3.6.0.

• The jQuery UI library was updated to version 1.13.1.

25.4 Closed issues
This release contains no closed issues.

25.5 Known issues
This release contains no known issues.
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CHAPTER 26
All release notes

This chapter contains the following topics:

1. Version 1.9.7

2. Version 1.9.6

3. Version 1.9.5

4. Version 1.9.4

5. Version 1.9.3

6. Release Note 1.9.2

7. Release Note 1.9.1

8. Release Note 1.9.0

9. Release Note 1.8.1

10.Release Note 1.8.0

11.Release Note 1.7.3

12.Release Note 1.7.2

13.Release Note 1.7.1

14.Release Note 1.7.0

15.Release Note 1.6.0

16.Release Note 1.5.4

17.Release Note 1.5.3

18.Release Note 1.5.2

19.Release Note 1.5.1

20.Release Note 1.5.0

21.Release Note 1.4.4

22.Release Note 1.4.3

23.Release Note 1.4.2

24.Release Note 1.4.1

25.Release Note 1.4.0

26.Release Note 1.3.1
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27.Release Note 1.3.0

28.Release Note 1.2.1

29.Release Note 1.2.0

30.Release Note 1.1.0

31.Release Note 1.0.1

32.Release Note 1.0.0

26.1 Version 1.9.7
Released: March 2022

New features
This release contains no new features.

Changes in Functionality
This release contains no functionality changes.

Changes to third-party libraries
The following third-party libraries were updated:

• The Apache FontBox library was updated to version 2.0.25.

• The JQuery library was updated to version 3.6.0.

• The jQuery UI library was updated to version 1.13.1.

Closed issues
This release contains no closed issues.

Known issues
This release contains no known issues.

26.2 Version 1.9.6
Released: December 2021

New features
This release contains no new features.

Changes in Functionality
This release contains no functionality changes.

Changes to third-party libraries
The jQuery UI library was updated to version 1.13.0.
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Closed issues
This release contains the following closed issues:

• [IGOV-1100] Validate field inputs.

• [IGOV-1102] Validate data repository inputs.

Known issues
This release contains no known issues.

26.3 Version 1.9.5
Released: August 2021

New features
This release contains no new features.

Changes in Functionality
This release contains no functionality changes.

Changes to third-party libraries
This release contains the following third-party updates:

• Apache Commons Compress to version 1.21.

Closed issues
This release contains no closed issues.

Known issues
This release contains no known issues.

26.4 Version 1.9.4
Released: May 2021

Product updates
This release contains the following updates:

• The Apache Batik library was upgraded to version 1.14.

• The Apache FontBox library was upgraded to version 2.0.23.

• The Apahce Commons IO library was upgraded to version 2.8.0.

26.5 Version 1.9.3
Released: January 2021
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Product updates
The Apache Common Codec library was upgraded to version 1.13.

26.6 Release Note 1.9.2
Release Date: September 18, 2020

Product update
• The add-on has been updated to support the OpenJDK8 and OpenJDK11 libraries.

• Libraries were updated to fix some potential issues.

26.7 Release Note 1.9.1
Release Date: June 23, 2020

Product update
The jQuery library was updated to version 3.4.0 and the log4j version 1.12.7 and dom4j version 1.6.1
libraries were removed.

Bug fixes
[IGOV-1070] An add-on description in French is not translated.

26.8 Release Note 1.9.0
Release Date: June 20, 2019

New features and updates
This release contains the following new features and updates:

• The add-on's services have been adapted and are now fully compatible with TIBCO EBX® 5.9.0
and later.
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• When viewing a RACI matrix in the Party tab, the display orientation of the parties can be
toggled. The parties can be displayed horizontally in the top row, or vertically in the first column.
The following image highlights this feature:

• A RACI matrix can now be exported to an Excel file. The following image shows an example
of an exported file:
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26.9 Release Note 1.8.1
Release Date: March 25, 2019

New features
Support has been added to take into account the new version of the TIBCO EBX™ Information Search
Add-on 2.4.0.

26.10 Release Note 1.8.0
Release Date: October 26, 2018

Adaptation
This release of the EBX® Information Governance Add-on has been partially adapted to the EBX®
5.9.0 GA release. The add-on's built-in services will be available in a future release. You can still
manually create administered items. However, the item description metadata from the DMA cannot
be synchronized. This functionality will be restored once adaptation efforts are complete.

26.11 Release Note 1.7.3
Release Date: May 2, 2018

New features
• Support has been added to take into account the new version of the TIBCO EBX™ Digital Asset

Manager Add-on.

26.12 Release Note 1.7.2
Release Date: March 16, 2018

New features
• Support has been added to take into account the new version of the TIBCO EBX™ Information

Search Add-on.

26.13 Release Note 1.7.1
Release Date: September 29, 2017

New features
• Support has been added to take into account the new version of TIBCO EBX™ Information

Search Add-on 2.0.0.

26.14 Release Note 1.7.0
Release Date: April 18, 2017
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New features

Export PDF
Property and Object Class Administered Items can be exported to a PDF file.

Bug fixes
• [25494] Unauthorized access to resources is possible.

Warnings
• Customers are strongly advised to upgrade to the latest version which patches the security

issue.

26.15 Release Note 1.6.0
Release Date: December 16, 2016

New features

Business Glossary updates
• The Icon bar has been added to serve as a quick-reference for information regarding the selected

Administered Item.

• You can now restrict user access to data models.

• You are now able to see information about the data model selected in the Browse tab.

• It is now possible to specify which icons represent Item quality information in the Business
Glossary. You can set icons for 'Approval', 'Deployment', and 'Quality'.

Synchronize metadata
• The 'Synchronize metadata' service has been added to synchronize manually created Items with

their data model. The 'Refresh Administered Items' service no longer synchronizes them.

RACI inheritance
• Properties can now automatically inherit parties and roles from parent Object Classes in the RACI

view.

Data model declaration
• The 'Data model' field has been added to the 'Data model' table. You are now able to select a

published data model to use as the basis for Administered Item management.

Export to relational service
• This service has been removed from the 'Data model' table. The export dataspace and dataset

remain for now, but they will be removed in a future release.
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Data quality integration
• You can now configure dashboards (titles) for the Association Item.

Tag link improvement
• Tag links can be easily added using a record's new 'Insert' button.

Repository hierarchies
• You can now assign icons to represent different types of Administered Items when viewing the

'Item' table as a hierarchy.

• The 'Party hierarchy' table has been added to represent the parent/child relationship between
parties.

Table for extended attribute
• The new 'Restricted to data model' field has been added to restrict the Items from a data model

that can access this table.

• The new 'Automatic display' field has been added to specify whether or not this table automatically
displays when users open the related Item.

API
• New APIs have been added that allow you to run the 'Data model' table services.

26.16 Release Note 1.5.4
Release Date: October 28, 2016

New features

Dynamic info-tip and labels
• You are now able to hide the universal name on the info-tip using the 'Hide universal name' field.

• The linked rules name and description can be displayed on the info-tip using the 'Display rule
information' property.

• The 'Maximum number of rules' property can be used to activate or deactivate the rules and
configure how many rules to display.

Repository hierarchies
• The 'View misaligned meta-data' hierarchy view has been replaced with the tabular view.

• The 'Data repository' has been added to the top hierarchy level in all the hierarchy views of the
'Item' table.

Excel import/export
The 'Logical name' field has been added to the exported Excel file when using Light mode.
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Property names and UI labels
• The 'Object Class' field in the 'Is association' group has been renamed to 'Linked Object Class'.

• You can now edit the records in the 'ISO type' table.

26.17 Release Note 1.5.3
Release Date: August 4, 2016

New features

'Physical' tab Administered Items
The 'Physical' tab has been added to 'Item' table and displays item fields related to the data model.

26.18 Release Note 1.5.2
Release Date: June 10, 2016

Bug fixes
• [20874] An Excel file cannot be imported if it contains a blank cell.

26.19 Release Note 1.5.1
Release Date: May 19, 2016

New features

Light mode in the 'Export in Excel' service
• When a file is exported using 'Light mode', it can be imported using the 'Import from Excel'

service.

Import from Excel spreadsheet
• Rather than creating Administered Items manually, you can import them from an Excel file.

Bug fixes
• [20280] Wrong results in the exported Excel file when running 'Export in Excel' service from the

occurrence page.

• [20291] The preview button is missing when Extended attribute value is a URL.

26.20 Release Note 1.5.0
Release Date: April 13, 2016
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New features

Administered Item creation and history
• You can now manually create an Administered Item using the API.

• While manually creating an Administered Item, its type 'Data reference' property allows you to
select the node's path in the logical data model. Previously, you had to type in the full path, which
could prove difficult in large data models. Note that if you've already run the 'Create Administered
Items' service on a data model, the option to automatically select a node path-while manually
creating an item in that model-will not be available.

• The 'Universal name' field is now required and must be added to any Administered Item created
manually.

• If an association is created manually, its related 'Object Class', 'Minimum occurrence' and
'Maximum occurrence' properties can be added manually.

• A history of Administered Item modifications is stored in the 'History' table. This behavior is
turned on/off in the 'User preference' table. A 'Stack size' property is also available to define, which
determines whether the number of stored history records follows a first-in/first-out approach and
how many records get stored before the process of overwriting begins.

Graph view integration
• Administrators are able to specify whether users can see the 'Graph' and 'Meta Graph' tabs by

adjusting configurations in the 'User preference' table.

RACI style view
• A RACI style matrix including images is displayed when viewing parties, roles and types. This

behavior is implemented when viewing an item in the repository and when viewing an item in
the Business Glossary.

Business Glossary updates
• The Business Glossary is now using an AJAX component that improves loading time and allows

the glossary to use the documentation pane.

• How tab labels and attributes are displayed has been overhauled and gives users more fine-grained
control over Business Glossary look and feel.

• A new 'List view' was added to the 'Query panel' that allows you to browse Object Classes and
Properties in the selected data model.

• When an Administered Item is linked in an email, the recipient can open it directly in the Business
Glossary.

Emailed Items
• Links to Administered Items now open directly in the Business glossary making all of the item's

information readily available.

Repository hierarchies
• A new data model structure was created for the 'Classification' group.
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Property names, values and UI labels
• The default value of the 'Search tab view by default' property is now 'No'.

• The default value of the 'De-duplication is active' property is now 'No'.

• 'Additional data' is now 'Additional attribute' and 'Extended data' to 'Extended attribute'.

• The 'Context' labels no longer contain the [ON] prefix when displayed via the 'Item' table.

• The 'Confidentiality' labels no longer contain the [ON] prefix when displayed via the 'Item' table.

• The [ON] prefix has been removed from the 'State' and 'Operation' table labels.

26.21 Release Note 1.4.4
Release Date: February 26, 2016

Adaptation
Adaptation of the UI to the new EBX® 5.7.0 ergonomics and layouts.

26.22 Release Note 1.4.3
Release Date: February 4, 2016

Adaptation
Adaptation of the UI to the new EBX® 5.7.0 ergonomics and layouts.

26.23 Release Note 1.4.2
Release Date: January 18, 2016

Bug fixes
• [18677] An error message displays when a user selects December as the input date.

26.24 Release Note 1.4.1
Release Date: July 23, 2015

Metadata creation
• When you create metadata manually from the data hierarchy view, the basic attributes are now

fed by default depending on your position in the hierarchy: 'Data model', 'ISO type' or 'Logical
data type'.

• Two new services allow you to create metadata from the data hierarchy's data model level: 'Create
an Object Class' and 'Create a Property'.

Data repository extension
You can now declare new attributes based on any EBX® table-even tables not under EBX®
Information Governance Add-on (IGov) control-while maintaining the safeguards ensured by IGov.
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This is accomplished through an extension of the IGov data model by referring to a table and a field
using the 'Meaning' and 'Value' properties, respectively. For example, you might have a 'Product'
Object Class under IGov control and want to add a new 'Law name' attribute from a data model not
under IGov control. To achieve this you would declare the 'Law' table and 'name' field to extend
'Product' attributes. Then, when defining 'Product' metadata, you can choose the appropriate 'Law
name'.

Data hierarchy display
The 'Data model unset' item is now hidden from the data hierarchy view.

26.25 Release Note 1.4.0
Release Date: June 10, 2015

Metadata creation
• You can now create metadata, or 'Administered Items' manually. In the previous add-on version,

' Administered Items' were created using an introspective lookup in the data model. After manual
creation, you can link metadata to a data model element, such as a table or field. It does not matter
whether metadata was created automatically, or manually; alignment between an 'Administered
Item' and its related data model(s) is fully enforced.

• By allowing manual creation of metadata, business users can enter definitions and descriptions
to anticipate new data design. These definitions and descriptions represent data business
requirements.

Metadata deletion
You can now delete metadata in a logical mode. A 'purge' service performs physical deletion of
logically deleted metadata.

Business glossary UI customization
• Information displayed in the 'Business glossary UI' can be configured as follows: 'Always

displayed', 'Display if defined' and 'Always hidden'. This feature affords you complete control
over the entirety of the 'Business glossary UI' based on user-profiles and end-user expectation.

• You can now configure a link from metadata to the actual data value. For instance, when
displaying metadata for 'Product', a link allows opens the 'Product' table to get the actual data
value. The data displayed depends on the users permission level.

• The fuzzy search panel is now extended with filters applied to the data type. For instance, this
allows you to look for metadata applied to the 'Table' type only, ignoring metadata applied to
other concepts such as 'Field', 'Group of fields', etc.

User comments management
Comments can be posted on all metadata and shared with users that have subscribed as recipients.

Definition and description
The definition and description context management now relies on a direct sortable data structure
(arrow up/down) that replaces the 'Apply' button.
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Export to Excel spreadsheet
The export process into an Excel spreadsheet has been improved. Now the spreadsheet is based on a
multi-folders data structure that makes the exported data value clearer.

Data quality integration
You can integrate data quality information when displaying metadata. This information is delivered as
dashboards (tiles) stemming from the TIBCO EBX™ Insight Add-on. For instance, when displaying
the definition and description of the 'Client' metadata, a 'Quality' tab is available and contains the
results of the 'Client' table's existing quality indicators.

26.26 Release Note 1.3.1
Release Date: April 9, 2015

TIBCO EBX™ Graph View Add-on 1.1.0
Support has been added to take into account the new version of TIBCO EBX™ Graph View Add-
on 1.1.0.

26.27 Release Note 1.3.0
Release Date: January 26, 2015

Web Business glossary UI
Metadata can now be accessed through a web application outside the EBX® user interface. Authorized
users can easily browse the Business glossary or search for information and/or metadata contained in
an EBX® Information Governance Add-on repository. This is accomplished using an interface that
provides access to data much in the same way as traditional web-based front-end application.

Management of relationships between Object Class items
The EBX® association modeling concept is now used to document relationships between Object
Class items. This modeling concept allows the repository to provide meaningful documentation of
the relationships regardless of the underlying join tables. The ability to directly document foreign key
fields and join tables is still possible.

New metadata and display
Several metadata have been added to enrich the description of Administered items such as:
'Application', 'Confidentiality', 'Maintenance rules', 'Identifying properties', 'Rules', etc.

26.28 Release Note 1.2.1
Release Date: October 10, 2014
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New feature
• It is now possible to add any bespoke data to complement with pre-defined meta-data. A group of

information 'Additional data' is then available in the main definition part of every Administered
item.

26.29 Release Note 1.2.0
Release Date: September 12, 2014

Dynamic management of table and field labels
The EBX® Information Governance Add-on API lets you customize table and field labels using the
governance repository content. For instance, a table labeled 'Empl' in the data model, can display
the labels 'Employee' or 'Staff' depending on the context associated with a user's profile. This is
accomplished by means of an automatic lookup in the governance repository.

Trigger extension on the metadata
It is now possible to configure a trigger extension (Java class) on the table 'Administered item'. The
Java class is then triggered during the Administered item modification and creation processes. This
trigger extension can perform any type of actions: workflow execution, rules execution, data transfer,
etc.

Graphical view of the metadata
The TIBCO EBX™ Graph View Add-on can be used to get graphical views of the metadata. When
this add-on is installed, two tabs appear to get the graph views applied to the 'Data model' under
governance, and the EBX® Information Governance Add-on repository by itself.

New metadata and display
• The metadata 'Is field' is enriched with its data type declared in the associated data model. In

case the metadata 'Is field' is a foreign key, then the link to the associated Administered item is
provided.

• The metadata 'Is property' is enriched with all the associated 'Data elements' using it. For
instance the 'Age' property can be used in many tables with different data types such as:
Empoyee.age[18..70], Company.age[1..200], etc.

• The metadata 'Is table' is enriched with the links to its associated Object Classes when there are
one or many relationships with this table (foreign keys).

• New metadata 'Logical label' is now available on the Administered Items' main tab to display the
naming from the logical data model.

• It is now possible to hide any Administered item by using the properties 'Is hidden' and 'View by
only'. It allows you to hide metadata such as technical data, and filter the metadata by user-profile.

• A user preference configuration allows you to decide if the 'Is hidden' and 'View by only'
properties are active or not. The UI tab 'Also defined in' can be hidden.

• The data models can now be grouped by 'Data repository' to get a better alignment with the
Enterprise Data Architecture patterns.
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Export the governance repository
• The governance repository can be exported into a flat relational table. From this table, the

metadata can be exported in XML format or as an Excel spreadsheet. The metadata can then be
queried using a third-party tool.

• The governance repository can be exported into a normalized relational table. From this table the
metadata can be handled from data hierarchy views in EBX® and queried using a third-party tool.

Tag links
The resolved tag link label now includes the universal name of the linked item.

26.30 Release Note 1.1.0
Release Date: April 1, 2014

User interface improvements
• The definition and glossary text now use an HTML editor that allows rich rendering (fonts, bold,

italic, color, size, hyperlinks, images, etc.).

• This text can integrate tag links to refer to any information in the governance repository. For
instance, the text 'Refer to the item ai3392' is automatically transformed into 'Refer to the item
3392', where the hyperlink is computed using the key word "ai". A list of ready-to-use key words
is available to link to any information in the governance repository.

Query administered items
A new UI is now available to query the administered items based on criteria and dates.

Java API
• New API allows using the descriptions and glossary as documentation panes on the tables and

fields known to EBX®.
This API relies on a configuration to display the correct description and glossary depending on
the user context. For instance, a different description for the table 'Product' can be displayed for
the sales department and for manufacturing.

Migration procedure
The migration of an existing EBX® Information Governance Add-on repository from GA 1.0.1 to GA
1.1.0 requires executing the service 'Validate data with tag links'. This service automatically completes
the 'Identifier' fields used as references in the tag links. It exists as a service at the dataspace level
to migrate the repository.

26.31 Release Note 1.0.1
Release Date: January 22, 2014
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Universal name management
The 'Universal name' of composite Administered Item (Data Element Concept and Value Domain)
is now based on the universal name of the related Administered Items. It is possible to overload this
name and to reset it with the related Administered Items' names.

Smart UI
The size of the definition block is increased.
In the context naming definition of Administered Item, if the context is '[ON] DMA', the definition
is automatically calculated and is not user-modifiable.

26.32 Release Note 1.0.0
Release Date: November 25, 2013
EBX® Information Governance Add-on provides a "governance repository" to manage the metadata
applied to any assets known to EBX® (tables, fields, groups of fields, data types, workflows, rule).
These assets can be master data that is under the control of the MDM system or any data managed
by other applications.
The repository relies on the standard ISO-IEC 11179 (Information technology - Metadata registries
MDR) that defines a robust data structure for collecting and sharing the knowledge applied to any data.
It also provides a standard vocabulary to define the key concepts that a metadata repository must apply.
This means that the knowledge collected in the "governance repository" is independent of the tool.
Since the governance repository is built using EBX®, it benefits from the MDM features to govern
the metadata as real master data.

Business naming control
When a new element is entered into the repository, the add-on builds its 'default name' automatically.
This name is based on the underlying data model loaded into EBX®. This means that the default
name is related to the logical layer of the data management. This default name is inherited by another
field known as the 'universal name'. This name can be changed by the administrator of the repository.
This 'universal name' is related to the semantic layer of the data management. This two-level naming
approach ensures a clear relation between the logical and the semantic levels of the data.

De-duplication of identical knowledge
A de-duplication process is executed when new information is entered into the repository. It allows
checking if elements are duplicated. In this case, a shared definition of the related metadata can be
defined.

Synchronization between the semantic and the data logical layers
At any time, the relations between the logical layer (data models, workflow, rules) and the semantic
layer (governance repository) is synchronized. All properties existing at the level of the logical data
model are reused to provide a first level of the documentation automatically.

Operations
• Create all Administrated Items.
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• Delete all Administered Items.

• Refresh all Administered Items.

• Validate all Administered Items.

• Delete Administered Items recursively.

• Delete Administered Items with no data reference recursively.

Extended information management
• 'Party management' to connect any type of party to an Administered Item. Any party can be

configured to play any type of role.

• 'Classification management'. Any type of classification scheme can be used to arrange the
Administered Items by taxonomy.

• 'Relation management'. Any type of relationship between the Administered Items. The 'Contains'
relationship is automatically created between the Administrated Item that already have a structural
relationship defined in the logical data model (e.g. fields belonging to a table).
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